Cisco ICM/IP Contact Center Enterprise Edition WebView Installation and Administration Guide, Release 6.0(0)

ICM/IP Contact Center Enterprise Edition, Release 6.0(0)
May 2004

Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 526-4100
THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT
NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT
ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR
THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION
PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO
LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as
part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE
PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

CCIP, CCSP, the Cisco Arrow logo, the Cisco Powered Network mark, Cisco Unity, Follow Me Browsing, FormShare, and StackWise are trademarks
of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn, and iQuick Study are service marks of Cisco Systems, Inc.; and Aironet,
ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCNA, CCNP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco IOS, the Cisco IOS logo,
Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo; Empowering the Internet Generation, Enterprise/Solver, EtherChannel,
EtherSwitch, Fast Step, GigaStack, Internet Quotient, IOS, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness Scorecard, LightStream, Linksys,
MGX, MICA, the Networkers logo, Networking Academy, Network Registrar, Packet, PIX, Post-Routing, Pre-Routing, RateMUX, Registrar,
ScriptShare, SlideCast, SMARTnet, Strataview Plus, Stratam, SwitchProbe, TeleRouter, The Fastest Way to Increase Your Internet Quotient,
TransPath, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply
a partnership relationship between Cisco and any other company. (0402R)

Cisco ICM IP Contact Center Enterprise Edition Web View Installation and Administration Guide, Release 6.0(0)
Copyright © 2000–2004, Cisco Systems, Inc.
All rights reserved.
About This Guide ix
Objective ix
Audience ix
Organization ix
Conventions xi
Related Publications xi
Other Publications xii
Obtaining Documentation xiii
Cisco.com xiii
Ordering Documentation xiii
Documentation Feedback xiii
Obtaining Technical Assistance xiv
Cisco Technical Support Website xiv
Submitting a Service Request xiv
Definitions of Service Request Severity xv
Obtaining Additional Publications and Information xvi

CHAPTER 1

WebView System Requirements 1-1
Overview 1-1
The WebView System 1-1
WebView Architecture 1-2
Client System Sizing for ICM 6.0 1-3
Server System Sizing and Scaling for ICM 6.0 1-3
Server Hardware Guidelines 1-3
APPENDIX C  Date Format Support  C-1

APPENDIX D  About Template and Report Item Caching  D-1
   Overview  D-1
   How WebView uses Caching  D-1
   Configuring Basic Caching  D-2
      Enabling and Disabling Caching  D-2
      Setting the Cache Refresh Time  D-3
      Setting the Cache Purge Time Factor  D-3
   Enabling and Disabling Supervisor Caching  D-4

APPENDIX E  How To Update or Fix Corrupted Templates  E-1
   What the PATCHPBL Utility Does  E-1
   How to Run the PATCHPBL Utility  E-2

APPENDIX F  Registry and Property File Settings  F-1
   Registry Settings  F-1
      AllowAdminLogin  F-1
      Event  F-2
   Property Files  F-3
      WebView.properties  F-3
      jagconnection.properties  F-3
      wvLocale.properties  F-3
      adminui.properties  F-3

APPENDIX G  Troubleshooting Tips  G-1
   Tip Organization  G-1
   Overview  G-1
Contents

Troubleshooting by following the WebView system program-execution flow G-3
  The program-execution flow in Figure G-1 described G-4
Error 2221 when installing AW as a real-time distributor G-5
Unable to Log into WebView G-5
Graphical Reports and the Job Scheduler:
  Incorrect display and improper function G-6
Getting Object support and ActiveX control support error messages when using
  the Job Scheduler G-8
Third-Party Software Installation Error Message:
  IIS Admin Service not correctly configured G-9
World Wide Publishing Service:
  Stopping it and restarting WebView G-10
Java code displayed on opening Webview G-11
Error message on attempting to select a WebView template G-12
Error message after changing the Jaguar Admin Password G-12
Large or many historical reports slow the system G-13
WebView-Only User Unable to Change Password G-14
Jaguar Server Installation Fails G-14
The Windows Scripting Host must be installed G-16
Slow Logger Performance or ICM Logger crashes G-17
Agent Data Does Not Show Up in Reports G-17
About This Guide

Objective

This manual describes how to use Cisco Intelligent Contact Management (ICM) software to install and maintain the Cisco ICM software WebView product. It includes installation information for the third-party software that WebView requires.

Audience

This document is intended for Cisco ICM WebView administrators. The administrator should have a general understanding of contact center operations and management and specific information about the contact centers and carrier networks connected to Cisco ICM software. The administrator should also have a good understanding of Windows 2000.

Organization

The manual is divided into the following sections.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “WebView System Requirements”</td>
<td>The WebView system requirements of servers and clients.</td>
</tr>
<tr>
<td>Chapter 2, “Installation Requirements”</td>
<td>The software and hardware installation requirements.</td>
</tr>
</tbody>
</table>
## Chapter Description

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3, “Installing Cisco ICM WebView Software and Setting Up Users”</td>
<td>How to install WebView software on your server and how to set up your WebView end-users.</td>
</tr>
<tr>
<td>Appendix A, “Upgrading From a Previous Version of ICM WebView”</td>
<td>Describes what you should be aware of if you’ve changed the names of custom templates. See the Cisco ICM/IP Contact Center Enterprise Edition Upgrade Migration Guide for how to upgrade from a previous version of WebView software.</td>
</tr>
<tr>
<td>Appendix B, “The WebView Database”</td>
<td>Describes the WebView Database and how WebView uses it.</td>
</tr>
<tr>
<td>Appendix C, “All WebView Database Tables”</td>
<td>Describes the WebView database tables.</td>
</tr>
<tr>
<td>Appendix C, “Date Format Support”</td>
<td>A list of the international date formats that WebView supports.</td>
</tr>
<tr>
<td>Appendix D, “About Template and Report Item Caching”</td>
<td>Explains how WebView uses caching, which improves system performance by reducing the number of times that WebView has to query the database.</td>
</tr>
<tr>
<td>Appendix E, “How To Update or Fix Corrupted Templates”</td>
<td>A method for fixing Cisco-supplied templates if they become corrupted.</td>
</tr>
<tr>
<td>Appendix G, “Troubleshooting Tips”</td>
<td>WebView installation troubleshooting tips not included in Chapter 3.</td>
</tr>
</tbody>
</table>
Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for user entries, keys, buttons, and folder and submenu names.</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Italic type indicates one of the following:</td>
<td>• A skill group is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>• A newly introduced term</td>
<td>• Do not use the numerical naming convention that is used in the predefined templates (for example, persvc01).</td>
</tr>
<tr>
<td>• For emphasis</td>
<td>• IF (condition, true-value, false-value)</td>
</tr>
<tr>
<td>• A generic syntax item that you must replace with a specific value</td>
<td>• For more information, see the Cisco ICM Software Database Schema Handbook.</td>
</tr>
<tr>
<td>• A title of a publication</td>
<td></td>
</tr>
<tr>
<td>An arrow (&gt;) indicates an item from a pull-down menu.</td>
<td>The Save command from the File menu is referenced as <strong>File &gt; Save</strong>.</td>
</tr>
</tbody>
</table>

Related Publications

**Cisco ICM Enterprise Edition Installation Guide**

Describes how to install the components of ICM software, including information about hardware configuration and software setup.

**Cisco ICM Enterprise Edition Configuration Guide**

Describes how to use the Configuration Manager to configure an ICM contact center.

For specific information on an ACD or NIC, see the appropriate Cisco ICM software ACD or NIC supplement documentation or ask your customer representative for that documentation.

**Cisco IP Contact Center Enterprise Edition Installation and Configuration Guide**

Describes how to install and configure the ICM components that are used for the Cisco IP Contact Center (IPCC) solution. This manual includes installation and configuration instructions for the ICM components used in an
IPCC solution. It also includes information on configuration requirements for other IPCC components that interface with the ICM software, including the Cisco Call Manager, Cisco IP-IVR and Cisco Agent Desktop/Cisco Supervisor Desktop.

Cisco IP Contact Center Enterprise Edition Administration Guide
Describes tasks and concepts required for day-to-day operation of an IPCC contact center. This guide includes information for multichannel options as well as voice.

Cisco ICM Enterprise Edition Administration Guide
Describes tasks and concepts required for day-to-day operation of an ACD contact center.

Cisco ICM/IP Contact Center Enterprise Edition Database Schema Handbook
Documents how data is organized in the databases for the Cisco Intelligent Contact Management (ICM) software. The databases contain tables. Each table defines a set of columns or fields. Each record or row in the database has one value for each column. This manual describes the tables and their columns. The WebView reports access their data from these tables.

Cisco ICM/IP Contact Center Enterprise Edition Upgrade Migration Guide
Describes how to upgrade ICM software.

Cisco IP Contact Center Enterprise Edition Reporting Guide
Provides information to help you understand how reporting data is generated and how to interpret reporting data in an IPCC Enterprise Environment. This guide also explains the implications of configuration and scripting on reporting data, enabling you to plan and deploy your IPCC Enterprise system to meet your reporting needs. This guide does not contain information on reporting in a traditional ACD contact center environment.

Cisco ICM/IP Contact Center Enterprise Edition WebView Template Design Guide Using InfoMaker
Describes how to use Sybase’s InfoMaker to create custom report templates and provides instructions on how to launch these templates using WebView.

Other Publications
For additional information about Cisco Intelligent Contact Management (ICM) software and the IPCC enterprise solution, see the customer contact software section at the Cisco web site.
Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several ways to obtain technical assistance and other technical resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/univercd/home/home.htm
You can access the Cisco website at this URL:
http://www.cisco.com
You can access international Cisco websites at this URL:

Ordering Documentation

You can find instructions for ordering documentation at this URL:
You can order Cisco documentation in these ways:
• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from the Ordering tool:
• Nonregistered Cisco.com users can order documentation through a local account representative by calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in North America, by calling 800 553-NETS (6387).

Documentation Feedback

You can send comments about technical documentation to bug-doc@cisco.com.
You can submit comments by using the response card (if present) behind the front cover of your document or by writing to the following address:

Cisco Systems  
Attn: Customer Document Ordering  
170 West Tasman Drive  
San Jose, CA 95134-9883  
We appreciate your comments.

**Obtaining Technical Assistance**

For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service contract, contact your reseller.

**Cisco Technical Support Website**

The Cisco Technical Support Website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 365 days a year at this URL:  

http://www.cisco.com/techsupport  

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:  


**Submitting a Service Request**

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool automatically provides
recommended solutions. If your issue is not resolved using the recommended resources, your service request will be assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

**Definitions of Service Request Severity**

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your business operation are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.
Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL: http://www.cisco.com/go/marketplace/
- The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as ordering and customer support services. Access the Cisco Product Catalog at this URL: http://cisco.com/univercd/cc/td/doc/pcat/
- Cisco Press publishes a wide range of general networking, training and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL: http://www.ciscopress.com
- Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and networking investments. Each quarter, Packet delivers coverage of the latest industry trends, technology breakthroughs, and Cisco products and solutions, as well as network deployment and troubleshooting tips, configuration examples, customer case studies, certification and training information, and links to scores of in-depth online resources. You can access Packet magazine at this URL: http://www.cisco.com/packet
- iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies learn how they can use technology to increase revenue, streamline their business, and expand services. The publication identifies the challenges facing these companies and the technologies to help solve them, using real-world case studies and business strategies to help readers make sound technology investment decisions. You can access iQ Magazine at this URL: http://www.cisco.com/go/iqmagazine
- Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the Internet Protocol Journal at this URL: http://www.cisco.com/ipj
World-class networking training is available from Cisco. You can view current offerings at this URL:

WebView System Requirements

Overview

This chapter contains the following topics:

- The WebView System, page 1-1
- WebView Architecture, page 1-2
- Client System Sizing for ICM 6.0, page 1-3
- Server System Sizing and Scaling for ICM 6.0, page 1-3

The WebView System

WebView is a two-tier client/server reporting query and presentation product. A set of at least one WebView server supports a number of clients:

- The WebView client is simply a Windows-based PC or workstation running a web browser. (Unix based clients are neither qualified nor supported yet, though, by design are not precluded.)
- The WebView server is an ICM Admin Workstation running MS Windows 2000 Server and IIS 5.0 with WebView installed. The WebView server may or may not also be a Historical Database Server.
WebView Architecture

The WebView server, the Administrative Workstation (AW), the WebView real-time database, the WebView database, the WebView historical database and the HDS (Historical Database Server) are all on the same hardware platform.

Note

The WebView HDS is required. If you install WebView on a distributor AW not configured as an ICM HDS (Historical Database Server), you can overload the work of the ICM logger and possibly crash it. See the Cisco ICM Enterprise Installation Guide and the ICM Setup online help for installation instructions.

Figure 1-1 Current WebView Reporting Architecture
Client System Sizing for ICM 6.0

- Windows 2000 Professional SP4 or Windows XP SP1a
- Internet Explorer, version 6.0 SP1
- 200 MHZ CPU
- 64M RAM
- 1G disk

Server System Sizing and Scaling for ICM 6.0

Server sizing and scaling is less straightforward. Small single-site contact center ICM installations may demand little of the WebView server, and it can co-reside with most other components. The ICM Historical Database is the component that is always required to be on a separate server.

For large or highly distributed installations with many WebView clients and/or with large historical databases, it is necessary to have multiple dedicated server-class WebView servers installed on dedicated ICM Historical Database Servers.

Exact sizing requirements are dependent on your database and system usage.

Server Hardware Guidelines

- Windows 2000 Server (ICM 6.0) SP4
- >650 MHz CPU
- 2G RAM
- 40G disk (non HDS)
- HDS disk sizing dependent on DB archive requirements.
- CD ROM drive
Server Use Guidelines

- Use the Job Scheduler to schedule historical reports, especially reports with lots of data, to be run at off peak hours when you do not require real-time reports.
- If you have many historical reports to repeatedly run, you might consider assigning a WebView server to run only historical reports while another WebView server runs only real-time reports. That way the historical reports will not delay the running of your real-time reports.

The simplest way to separate the servers is to ask the users to use one URL for real-time reports and a separate URL for historical reports. So that users can see only those templates that should be run on a server, you can also delete the real-time templates on one WebView server (using the Custom Screen Builder), and delete the historical templates on the other server.

General Scaling Guidelines

Scenario 1. Test bed, lab or very small single-site market: less than 50 agents.

If an installation is single-site, Call Termination or Route Details are not required, and there are 3 or less simultaneous WebView clients, then the ICM Admin Workstation, WebView server and Logger can all reside on the same system. See the Cisco ICM Software Administrator Guide for system sizing requirements, but, for simple test/lab cases, systems somewhat smaller than the administrator guide requirements may often suffice.


If an installation is single-site, with less than 10 Meg of Call Termination or Route Detail records and less than 10 WebView clients, the WebView server can reside on the primary ICM Administrative Workstation.

If there are more than 10 simultaneous WebView clients, a separate WebView server/Admin Workstation is recommended. This WebView server can be associated with a standalone ICM Administrative Workstation. Additionally, a separate ICM Historical Database Server, or HDS is required if custom reports based on Call Termination or Route Details are required, or more than 20M records of historical data are kept.

Scenario 4. Medium-Large Enterprise Markets. greater than 500 agents, greater than 50 WebView clients.

If there are more than 50 simultaneous WebView clients, one WebView server for each set of 50 clients is recommended.

Note: As larger loads are qualified, this number will increase. Therefore, the hardware sizing listed below is based on scalability to larger loads.

Scenario 5. Large Service Provider Markets: less than 500 agents, multiple customer ICM instances, and less than 50 WebView clients.

If there are multiple CICM instances, each CICM must have a dedicated HDS. If there are more than 50 clients for each CICM, then an additional WebView Server AW for each set of 50 CICM clients is recommended. The HDS can function as a WebView server. In most cases, additional WebView Servers can be simple AW’s and be installed to redirect to the CICM HDS. In the most strenuous load cases, an HDS should be dedicated to each WebView Server.
Installation Requirements

Installing Cisco ICM WebView software on a real-time distributor Admin Workstation allows WebView to become a Web server on a corporate intranet. WebView Administrators and WebView Supervisors can log into WebView on this Web server from a browser on their own computer.

Overview

This chapter contains the following topics:

- Cisco ICM/IP Contact Center WebView Software AW Requirements, page 2-2
- Installing a Supported Web Browser, page 2-6
- Installing Windows 2000 Service Pack 4, page 2-7
- Installing the WebView Third-Party CD Software, page 2-8
- Changing the Jaguar Admin Password, page 2-11
- Setting the Size of the Jaguar Log File, page 2-13
- Deleting Jaguar Log Files, page 2-14
- Uninstalling the Third Party Software, page 2-14
- Checking WebView AW Time Synchronization, page 2-15
- Time Zones and How They Affect Reporting, page 2-16
Cisco ICM/IP Contact Center WebView Software AW Requirements

This section summarizes the hardware and software required for Cisco ICM WebView software.

Note
To install the Cisco ICM WebView software product, you must be an administrator in the same Cisco ICM software domain where the distributor Admin Workstation resides.

System Requirements

Confirm that your Admin Workstation:

- Is a real-time distributor Admin Workstation, rather than a client (non-distributor) Admin Workstation. For more information on how to do this, see the Cisco ICM/IP Contact Center Enterprise Edition Installation Guide.
- Has 128 MB of RAM and the following amount of free disk space for the Third-Party Software applications:
  - Sun JDK 1.3.1: 35 MB
  - New Atlanta ServletExec ISAPI 4.1.1 patch 9, 15: 5 MB
  - Sybase EAServer 4.1.1 (final disk size): 450 MB

Make sure that you have enough space on each drive for what you intend to install on that drive. While running, the installer software uses approximately 10 MB of RAM and 1 MB of space on the hard drive.

Note
If the drive runs out of space in the middle of the installation, EAServer hangs. In this case, you must end the installation process with the NT task manager and start over on a drive that has more space.
Chapter 2      Installation Requirements

Cisco ICM/IP Contact Center WebView Software AW Requirements

- Has a TEMP environment variable that is defined to be a folder with at least 300 MB of free space. This space is required by the EAServer installation.
- Have at least 300 MB of free space on C drive, regardless of which drive is the install drive. This is required by the EAServer Install. After the EAServer installation, the installation takes up no space on C, if that is not the install drive.
- Use the Microsoft Windows time synchronization facility to synchronize the time on the ICM WebView AW computer with the time on the ICM Central Controller.

**Note**

Do not use ICM synchronization (not available on the AW but available on the Central Controller and PG).

- If you plan to create new report templates for your users (in addition to the report templates provided with the WebView program), you must install the InfoMaker program from Sybase. If you install InfoMaker on the same machine on which WebView is installed, you must use InfoMaker 8.0.1. If InfoMaker on a machine that does not have web version of the Sybase InfoMaker program. This is the version of InfoMaker that WebView supported in ICM 5.0. WebView 6.0 does not support InfoMaker 8.0.4.

If you are not sure if your Admin Workstation meets these requirements, contact your Cisco ICM software representative.

**Upgrading from a Previous Version of Cisco ICM WebView Software**

If you are upgrading your installation from a version of Cisco ICM WebView software prior to ICM 4.6.2, uninstall the ChartFX application that was used by that previous version of WebView. For all other upgrade instructions, see the ICM 4.6/5.0 to 6.0 Upgrade Guide

In WebView 4.6.2, saved reports were stored in a directory on the WebView server. In WebView 5.0 and 6.0, a WebView database is used to store saved reports. During WebView installation, most saved report files are migrated to the WebView database, with two exceptions:

- Saved reports created with templates in WebView 4.6.2 that have been deleted and replaced by templates in different reporting categories are not migrated to the database.
- Saved reports created with templates in WebView 4.6.2 that have been deleted and not replaced are not migrated to the database. Only saved reports stored in the database can be accessed and used in WebView.

### Grouping Together Multiple Servers

Multiple WebView servers can be grouped together as one when you need to increase performance for many users. See the *Cisco ICM/IP Contact Center Enterprise Edition Installation Guide* for instructions.

### Third-Party Software Requirements

Make sure that you have all of the software listed in Table 2-1 ready to install before you begin enabling Cisco ICM WebView software.

While all of the preceding software is needed on the computer that is the WebView server, only a supported browser is needed on the computers that are the WebView Clients.

#### Table 2-1 Third-Party Software Requirements

<table>
<thead>
<tr>
<th>Third-Party Software</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 2000 Server, Service Pack 4</td>
<td>Install from your Microsoft CD or from the Web page</td>
</tr>
<tr>
<td>Sun JDK, Release 1.3.1</td>
<td>Cisco ICM WebView Third-Party Software CD</td>
</tr>
<tr>
<td>New Atlanta ServletExec ISAPI, 4.1.1 patch 9 and patch15</td>
<td></td>
</tr>
<tr>
<td>Sybase EAServer 4.1.1</td>
<td></td>
</tr>
<tr>
<td>EAServer 4.1.1 is an upgrade from Sybase Jaguar 3.6.1, which was used for ICM 4.6.2</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 2  Installation Requirements

Cisco ICM/IP Contact Center WebView Installation and Administration Guide, Release 6.0(0)

Table 2-1  Third-Party Software Requirements (continued)

<table>
<thead>
<tr>
<th>Third-Party Software</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licenses for New Atlanta ServletExec ISAPI 4.1.1</td>
<td>Cisco distributes and automatically installs the 1 and 2-CPU licenses for New Atlanta ServletExec ISAPI 4.1.1 patch 15 when WebView is installed. However, if you are installing WebView on a server that has 4 or more processors, then it is your responsibility to get a 4-CPU or greater than 4-CPU license from New Atlanta.</td>
</tr>
<tr>
<td>Supported browsers: Microsoft® Internet Explorer version IE 6.0 (SP1)</td>
<td></td>
</tr>
<tr>
<td>Sybase InfoMaker 8.0.1 (if you plan on creating custom reports).</td>
<td>Sybase Inc.</td>
</tr>
<tr>
<td>Note that this must be installed before you install ICM. After it is installed, run ICM Setup and select the custom screen builder option in the AW setup. See the Cisco ICM/IP Contact Center Enterprise Edition Installation Guide for more information.</td>
<td></td>
</tr>
</tbody>
</table>

WebView Third-Party Software Licenses

Installing WebView on a server that has 4 or more processors

Cisco distributes and automatically installs the 1 and 2-CPU licenses for New Atlanta ServletExec ISAPI 4.1 when WebView is installed. If the server that you are installing WebView on has 4 or more processors, then you must get a 4-CPU or greater than 4-CPU license from New Atlanta.

How to install a 4-CPU or more license for New Atlanta

Step 1  Install the WebView third-party software. See Installing the WebView Third-Party CD Software. Then install WebView. See Appendix A, “Upgrading From a Previous Version of ICM WebView”
Installing a Supported Web Browser

Step 2 Obtain the license from New Atlanta if you have not already done so.

Step 3 Open the file \(\text{<NewAtlantaRoot>\ServletExec ISAPI\ServletExec Data\servers.properties, where <NewAtlantaRoot> is the New Atlanta directory; for example: C:\Program Files\New Atlanta.}\\)

Step 4 Change the line \(\text{servletexec.serial=<old_license>, where <old_license> is the old license number, to read servletexec.serial=<new_license>, where <new_license> is your new license number; for example: 1678290}\\)

Step 5 Save the file as a text file in the directory in which you found it.

Step 6 Restart the IIS Admin NT service for the change to take effect.

Supported Languages and Character Set

WebView and ICM6.0 support computer systems with the English language and with languages that use the ISO_1 character set that is used by Western European countries; for example: France, Germany, and Italy.

WebView should be installed on a computer having the same operating system character set as the one on which ICM 6.0 is installed.

If ICM WebView is installed on a computer system using a character set rather than ISO_1, you may see some garbled characters in the WebView Web pages and in the reports containing agent names and descriptions.

Installing a Supported Web Browser

To test your Cisco ICM WebView software installations, you must install the Microsoft Internet Explorer, Version 6.0 SP1 browser on the Admin Workstation.

To run WebView from a client machine, Internet Explorer, Version 6.0 SP1 must also be installed on the client.

See the Third-Party Software Requirements section preceding this section, for information about the web site where you can download the browser. Follow the download and installation instructions on the web site for the browser you decide to install.
Chapter 2  Installation Requirements

Installing Windows 2000 Service Pack 4

Updating Your Browser’s Cache

For your browser to display real-time report monitoring and script monitoring, you must enable the browser’s settings so that with every visit to a real-time report monitoring or script monitoring page, the version of that page in the browser’s cache will be compared and updated to any newer version on the Cisco ICM WebView software Admin Workstation. The following information was correct when this document was written, but you can refer to the help for your browser to confirm the correct procedure for your browser.

**Internet Explorer, version 6.0 SP1**

Use the following procedure to make sure the cache will be updated at each new view of a real-time report.

**How to ensure cache updates in Internet Explorer**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Internet Explorer window, choose <strong>Internet Options</strong> on the Tools menu.</td>
</tr>
<tr>
<td>Step 2</td>
<td>If necessary, click the <strong>General</strong> tab to display the General Settings tab page.</td>
</tr>
<tr>
<td>Step 3</td>
<td>On the General Settings tab page, in the Temporary Internet Files section, click <strong>Settings</strong>.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the Settings dialog box, enable the <strong>Every visit to the page</strong> option, then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>OK</strong> in the Internet Options dialog box.</td>
</tr>
</tbody>
</table>

Installing Windows 2000 Service Pack 4

For a description of the Windows 2000 Service Pack 4 and for installation instructions, see the ReadMe file that comes with the service pack.
Installing the WebView Third-Party CD Software

Use the WebView Third-Party Software CD for installing:

- Sun JDK1.3.1 software
- New Atlanta ServletExec ISAPI, 4.1.1 patch 9 and 15
- Sybase EAServer 4.1.1.

**Note**
EAServer 4.1.1 replaces the Jaguar 3.6.1 software. EAServer 4.1.1 can only be upgraded from Jaguar CTS 3.6.1 or higher.

If you have lower versions of Jaguar CTS, such as 3.5, already installed on your machine, you must first uninstall it before installing EAServer 4.1.1

**How to install the third-party software**

On the Third-Party CD, run the top level Setup.exe program. This first performs several checks on your system for software requirements, and then asks you to select the third-party software options you want to install and where you want that software located. Then it automatically installs the software. The installation procedure can take from 30 to 40 minutes depending on the speed of the machine and the resources available on the machine.

The following is a summary of the installation procedure. See the README.txt file on the third-party CD for any further information.

**Step 1**
Check to see if you have the Jaguar 3.5 software already installed on your machine.

If Jaguar 3.5 software is installed on your machine, use the control panel’s Add/Remove software program to remove that software.

**Step 2**
Check to see if you have Cisco Security Agent running on your machine.

If you are using Cisco Security Agent, suspend the security before running Setup.

**Step 3**
On the Third-Party CD, run the top-level Setup.exe program. Follow the instructions presented on the screen.
Chapter 2 Installation Requirements

Installing the WebView Third-Party CD Software

Step 4 The Setup program displays a list of the third-party software that is required by WebView. Any software that is not already installed on your system is automatically selected and grayed out in this dialog box. Any software that is already installed on your system, you can reinstall by selecting the check box next to that software option.

Note Cisco does not recommend installing EAServer 4.1.1 over itself to fix problems. Cisco recommends that you remove EAServer, using the steps in the readme.txt file on the Third-Party software installation CD, and then install EAServer using the Third-Party CD.

By default, the Setup program does not reinstall software that is already installed on your system if its version number has not changed since your last Third-Party CD installation. However, if you select to reinstall this software, then Setup first deletes the former installation before installing the new version.

Review all the automatically selected software options. If you want to re-install any unselected options, select them. Then click Next.

Step 5 When the procedure asks you to choose the destination location for the files, select or enter the directory location and click Next. If you previously installed the software, the default location will be that previous location. Cisco recommends that you choose the default.

The default locations for a new installation are:

- Sun JDK 1.3.1 (35 MB)  
  C:\jdk1.3.1\n
- New Atlanta ServletExec ISAPI 4.1.1 patch 9, 15: (5 MB)  
  C:\Program Files\New Atlanta\ServletExec ISAPI\n
- Sybase EAServer 4.1.1 (450 MB)  
  C:\Program Files\Sybase\EAServer

Note If you plan to use Cisco Security Agent, which Cisco highly recommends, you must always use the default directory when installing any software on a server. You need not choose the default disk drive if an option is available (For example, C: or D:), but you must use the default directory.
Chapter 2  Installation Requirements

Installing the WebView Third-Party CD Software

2-10

Cisco ICM/IP Contact Center Enterprise Edition WebView Installation and Administration Guide, Release 6.0(0)

As Setup installs the software, it displays status messages. At one point, three warnings appear in a console command-line window:
“Server Name not specified. Defaulting to Jaguar.
JDK Version not specified. Defaulting to JDK 1.3.
-jvmtype not specified. Defaulting to client.”

These messages mean that Setup is using the defaults.
The messages are produced by the EAServer installation and are expected.

Step 6 When the programs are installed, the Cisco WebView Third-Party Setup dialog box again displays and prompts you to select when you want to reboot your computer: next or at a later time. Make your selection and click Finish.

After you have rebooted your computer, the third-party software installation is completed.

Step 7 Verify that the Jaguar NT service is installed and started:

a. From the Start menu, select Programs > Administrative Tools > Services.

b. In the Services dialog box, make sure that Jaguar is listed and started:
   • If it is not started, right click on Jaguar and select the Start option from the pop-up selection box.
   • If it is not installed, run the following from the command line window:
     "%JAGUAR%\bin\serverstart.bat" -install
     Then, start the service as indicated in the preceding bullet.


Error Reporting

The installer creates a log file that records the installation progress and errors of the installation for diagnostic purposes. The log file is created in the C:\Temp directory. It is called WVThirdPartyInstaller.log

Any errors that occur during setup are displayed to the user and are recorded in the log file. The log file also contains other important information, such as the build number of the current wrapper installer, the various stages of program execution, minor errors not worth displaying to the user, system settings, and so on. Each entry in the log file contains a time stamp.
Changing the Jaguar Admin Password

After installing Jaguar, you might want to change the default Jaguar Admin password for security reasons. However, this is not required.

How to change the Jaguar Admin password

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Start menu, select Programs &gt; Sybase &gt; EAServer 4.1.1 &gt; Jaguar Manager. This opens the Sybase Central Java Edition dialog box.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In Tools menu of the Sybase Central Java Edition dialog box, select Connect &gt; Jaguar Manager. This opens the Login dialog box.</td>
</tr>
</tbody>
</table>
| Step 3 | In the Login dialog box, click Connect. If you get a message saying the user name field is empty:  
  a. Enter jagadmin in the User Name text box.  
  b. Enter <your machine name> in the Host Name text box.  
  
  **Note**  
  The previous version of Jaguar required you to enter “localhost.” However, EAServer 4.1.1 requires you to enter your machine name.  
  You can get your machine name by right clicking on the My Computer icon in your desktop and then selecting Properties from the pop-up menu. In the System Properties dialog box, the Network Identification tab displays your machine name.  
  c. You can leave the default (9000) in the Port Number text box.  
  d. Click Connect. |
| Step 4 | From the directory tree in the Sybase Central Java Edition dialog box, select Jaguar Manager > Servers > Jaguar. |
| Step 5 | In the menu bar, select File > Server Properties. |
| Step 6 | In the Server Properties:Jaguar dialog box, select the Security tab. |
| Step 7 | In the Administration box, click Setjagadmin Password. |
Step 8 In the **Administrator Password** dialog box, enter the password in the **New jadmin Password** text box and then re-enter it in the **Verify New jadmin Password** text box.

Step 9 Click **OK**. In the “The password has been changed.” message box, click **OK** again. Click **OK** a third time to close the Administration box. And then select **File > Exit** from the menu bar to close the Sybase Central Java Edition dialog box.

**Note** This step changes the password. However, the next set of steps are also necessary so that WebView knows what the new password is.

Step 10 In a text editor, open the file 
%Jaguar%\html\classes\com\cisco\atg\jagconnection.properties where
%Jaguar% is the system variable pointing to the directory location of the Jaguar (EAServer) files.

Step 11 In the file, after JAGCONNECT_JAGUAR_ADMIN_PWD=, enter your new password.

**Example jagconnection.properties File**

JAGCONNECT_CORBA_ORB_CLASS=com.sybase.CORBA.ORB  
JAGCONNECT_JAGUAR_SERVER=localhost  
JAGCONNECT_IIO_PORT=9000  
JAGCONNECT_JAGUAR_ADMIN=jagadmin  
JAGCONNECT_JAGUAR_ADMIN_PWD=  
JAGCONNECT_JAGUAR_SYS_BEAN=webview/n_icmsysinfo  
JAGCONNECT_JAGUAR_DW_BEAN=webview/n_icmdw

Step 12 Save the **jagconnection.properties** file.

**Note** The password will be encrypted by WebView the first time that it is used.
Setting the Size of the Jaguar Log File

Jaguar software writes to a log file as it processes information. The default log file size is 10 Megabytes. If you need to change its size, use the following procedure.

How to set the size of the Jaguar log file

Step 1  In the Start menu, select Programs > Sybase > EAServer 4.1.1 > Jaguar Manager. This opens the Sybase Central Java Edition dialog box.

Step 2  In Tools menu of the Sybase Central Java Edition dialog box, select Connect > Jaguar Manager. This opens the Login dialog box.

Step 3  In the Login dialog box:
   a. Enter jagadmin in the User Name text box.
   b. Enter <your_machine_name> in the Host Name text box.
   c. You can leave the default (9000) in the Port Number text box.
   d. Click Connect.

Step 4  In the directory tree box of the Sybase Central Java Edition dialog box, click Jaguar Manager and then the Servers branch.

Step 5  In the Servers column on the right side of the dialog box, right click on Jaguar and in the pop-up menu, select Server Properties.

Step 6  In the Server Properties dialog box, select the Log /Trace tab.

Step 7  In the Log/Trace tab:
   a. Enter the log file size in bytes in the Log File Size in bytes text box; for example: 1000000. The default is 5000000. When the log file reaches the set size, a new log file is created with the current date and time and the.log suffix.
   b. Remove the check mark from the Truncate Log on Startup check box.

Note that:
   • If this box is checked, then the jaguar log will be deleted every time that the Jaguar service is started (every time you restart WebView).
   • If this box is not checked, then the Jaguar log will grow to the Log File Size in bytes specified in Step 7a before being renamed and a new log file is created.
Deleting Jaguar Log Files

Once you set the log file’s size, Jaguar creates a new log file each time the data grows beyond the selected size. Consequently you can have many log files. You should delete old log files occasionally to keep them from unnecessarily consuming too much space on your system.

How to delete Jaguar Log Files

Step 1 Go to the Jaguar root directory where they are stored. The default location for this directory is **%JAGUAR%\bin**

where %JAGUAR% is an environment variable defined in windows.

Step 2 Select the outdated log files and delete them.

Uninstalling the Third Party Software

You can uninstall the third party software by using the Add/Remove Programs software in the Windows NT Control Panel.

Note

- Cisco does not recommend installing EAServer 4.1.1 over itself to fix problems. Cisco recommends that you remove EAServer, using the steps in the readme.txt file on the Third-Party software installation CD, and then install EAServer using the Third-Party CD.
If you remove the third party software files and then reinstall them, you should then run ICM Setup in Upgrade All mode to prevent any problems when using WebView. See Appendix G, “Troubleshooting Tips” for further information.

Checking WebView AW Time Synchronization

Make sure that the time on the WebView AW is synchronized with the time on the ICM Central Controller:

- If the AW is in the same domain as the Central Controller, then the time will automatically be synchronized. However, make sure that the windows time service is enabled on the AW.
- If the AW is in a different domain from that of the ICM Central Controller, then you can also use the `net time /domain:<central controller domain_name>` command to synchronize the time.

For example:

```
net time /domain:boston
```

Do not use ICM synchronization (not available on the AW but available on the Central Controller and PG). By default the Disable ICM Time Synchronization box is selected in ICM Setup (in the MDS & DMP Properties dialog box which appears when you select the advanced settings for the peripheral gateway component).

**Note**

If the time on the AW is not synchronized with the time on the Central Controller, then report execution time will not be synchronized with the data in the report. For example, if the AW time lags behind the Central Controller time by 2 minutes and a report is executed at 10:00 AM on the AW, then the report execution time on the WebView report would be 10:00 AM, but the report data could have a time of 10:02 AM.
Time Zones and How They Affect Reporting

In ICM, the producers of data are the PGs and NICs, which communicate with the central controller (router and logger). The table below shows the time synchronization and time zone dependencies between the various components in the reporting system relative to the router, which the ICM system assumes to have the correct time.

<table>
<thead>
<tr>
<th>Component</th>
<th>Time Synchronized with Router</th>
<th>Time Zone Synchronized with Router</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Logger</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PG/NIC</td>
<td>Yes</td>
<td>Not necessarily</td>
</tr>
<tr>
<td>AW</td>
<td>Not necessarily</td>
<td>Not necessarily</td>
</tr>
<tr>
<td>WebView Client</td>
<td>Not necessarily</td>
<td>Not necessarily</td>
</tr>
</tbody>
</table>

In Table 2-2, Not Necessarily means that the ICM components may be time or time zone synchronized with the router. However, there is no enforcement of this policy, nor is it reasonable to assume that your ICM system is automatically set up this way. For a detailed explanation of the how ICM handles time synchronization, see the Cisco ICM Enterprise Edition Administration Guide available on the Cisco Web site in the Documentation section of the Cisco Customer Contact software Web page.

Note

The Router, Logger, PG, and NIC need to be time synchronized in order for routing to happen correctly. However, the AW and the WebView client can be off by several minutes, and the reports should still make intuitive sense to the end user.
Central Controller Time Zone

As far as time zones go, the PG or NIC is not required to be in the same time zone as the central controller. However, all time that flows between the PG or NIC and the router is in GMT (Greenwich Mean Time) and thus time zones do not matter.

When the data eventually gets written to the central controller database by the logger or to the AW database or the historical database by the AW, all date and time values are converted to the central controller time zone. Thus, all data in the database is in terms of the central controller time zone.

Time Zone Data Field

In many (if not all) database tables that have a DateTime field, there is also a time zone field. The time zone field is the time zone of the central controller when the record was written. The time zone field is only really used for daylight savings time purposes so that the logger does not write duplicate keys in the database when we "fall back" (that is, time rolls back an hour for daylight saving time in the fall). The time zone of the PG/NIC that generated the data is not recorded in the database.

Note

Since all of the data in the database is written in central controller local time, all reporting done in WebView must be with respect to central controller time. For example, when a user selects a date and time range for an historical report, the user must enter the data with respect to the central controller’s time zone.

Locations of Date and Time Values in Reports

When a report is generated in WebView, there are three places that DateTime values appear:

- In the report header stating the datetime range that an historical report covers. This is relative to the central controller time zone.
- In the report data. This is relative to the central controller time zone
- In the report footer specifying when the report was run. This is relative to the WebView server's time zone.
Setting the Date Format Used for Reports

Three Time Zones for Report Viewing

WebView clients must be aware of the preceding 3 different time values and their corresponding 3 different possible time zones in order to properly view and understand a report. They must be aware of:

- Their own time zone
- The time zone of the WebView server
- The time zone of the central controller.

If the WebView user does not know any one of these values, then there exists the possibility that the user will misinterpret the data in the report, the time the report was run, or both.

Setting the Date Format Used for Reports

The format for the date range in reports is controlled by your browser's language settings. WebView is currently built to detect French, Chinese, Japanese, and UK English. If WebView does not detect any of the preceding languages, it will default to US-English (mm/dd/yyyy) format. For other language settings and more information on such, see Appendix C, “Date Format Support”.
Installing Cisco ICM WebView Software and Setting Up Users

After following the instructions in Chapter 2, you are ready to install (or update) the Cisco ICM WebView option on the Admin Workstation.

Overview

This chapter contains the following topics:

- Installing Cisco ICM WebView Software, page 3-2
- Installing WebView for ICM Instances and for Customers, page 3-4
- Creating a WebView User, page 3-5
- Logging into Your WebView Installation, page 3-7
- Troubleshooting Your WebView Installation, page 3-8
- Setting Up Other WebView Users, page 3-9
- WebView User’s Password Expiration and Domain Security Settings, page 3-9
- Supervisors and WebView Reports, page 3-10

For how to install the ICM system including the ICM databases, see the Cisco ICM/IP Contact Center Enterprise Edition Installation Guide and/or the Cisco IP Contact Center Enterprise Edition Installation and Configuration Guide. For
further information on installing your system and maintaining it, see the appropriate guide on the documentation page of the Customer Contact Software Web page at the Cisco.com Web site.

Installing Cisco ICM WebView Software

After the required software is installed, you are ready to install (or upgrade) the WebView option on the Admin Workstation. If you are installing the Admin Workstation software for the first time, see the Cisco ICM/IP Contact Center Enterprise Edition Installation Guide or the Cisco IP Contact Center Enterprise Edition Installation and Configuration Guide for information about installing the Admin Workstation.

Note

WebView cannot be installed on the same machine as another application that depends on a specific configuration of New Atlanta ServletExec. As part of the WebView (Third Party Tools) installation, the ServletExec configuration is overwritten, and thus cannot be reliably shared with another application that depends on it.

Use the following procedure to install Cisco ICM WebView software.

How to install WebView software

Step 1  Run Setup from the ICM CD. See the Cisco ICM/IP Contact Center Enterprise Edition Installation Guide for information on how to use the Setup program.

If you are installing the Admin Workstation software for the first time, you will be enabling the WebView option on the Admin Workstation Properties window. If you are upgrading from an earlier version of the Admin Workstation software, you will be completing the upgrade.

Step 2  In the Cisco ICM Setup dialog box, select AW in the Instance Components section on the right-hand side of the dialog box.

Step 3  In the same dialog box, in the ICM Instances section, on the left-hand side of the dialog box, select the ICM instance where the Admin Workstation running WebView will be installed.
Step 4  Click the **Edit** button associated with the Instance Components section on the right-hand side of the dialog box. The Admin Workstation Properties dialog box displays.

Step 5  Select one of the following languages:
- English (American)
- English (United Kingdom) with DD/MM/YYYY date format
- Japanese
- Simplified Chinese
- Korean
- French
- German
- Spanish

If your platform does not use one of the preceding languages, but you want to use the DD/MM/YYYY date format, you must select English (UK).

Step 6  Click **Next**. The Real-Time Distributor Node Properties dialog box displays.

Step 7  In the Real-Time Distributor Node Properties dialog box, enable the **WebView Reporting** option check box.

Step 8  In the WebView database host name text box, enter the **WebView database host name**. This is the name of the computer (for example: boston1) where you want to hold the database server which WebView uses to store saved reports, favorites reports, and scheduled jobs. This database allows you to have multiple WebView servers share the same WebView reports.

Step 9  Click **Next** and proceed with the setup. When the installation is complete, and you are prompted in the Cisco ICM Setup dialog box, you can exit from Setup.

Step 10  When you are prompted to do so, restart your system in order to ensure that all of the appropriate software is running.
Installing WebView for ICM Instances and for Customers

An instance is a single logical ICM system. An instance typically consists of several software components (CallRouter, Logger, Peripheral Gateways, Admin Workstations)—some of which may be duplexed—typically installed on several different computers. For example, a single computer can run multiple components of a single instance or components of multiple instances.

A customer is an organization that uses ICM software to manage its contact center enterprise. Each customer has its own dialed numbers, labels, call types, scripts, and scheduled targets. However, all Peripheral Gateways, peripherals, services, skill groups, and so on are associated with the instance rather than a specific customer. Therefore, customers who share an instance cannot have their own Peripheral Gateways. Such customers, however, can be assigned a network IVR with customer–specific scripts for special call treatment.

In Release 5.0, a single ICM instance can be shared by several customers with limited functionality. However, you can set up WebView users who have access to the data for only a specific customer.

Table 3-1 summarizes what data can be associated with a specific customer and what data is shared by an entire instance.

<table>
<thead>
<tr>
<th>Customer Data</th>
<th>Instance Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed numbers, labels, call types, scripts,</td>
<td>Network ICM systems and Peripheral Gateways; peripherals,</td>
</tr>
<tr>
<td>scheduled targets, and network VRU scripts</td>
<td>trunk groups, peripheral targets, skill targets; regions; announcements;</td>
</tr>
<tr>
<td></td>
<td>application gateways</td>
</tr>
</tbody>
</table>

See the Cisco Network Applications Manager (NAM) Setup and Configuration guide for how to configure and use the Cisco Network Applications Manager (NAM), instances, and customers.
You can use the customer concept to support multiple independent organizations with a single ICM instance rather than assigning a separate instance to each organization. However, customers that share an instance have more limited capabilities than a customer using a full instance. Table 3-2 summarizes the abilities of these two customer types for WebView users.

<table>
<thead>
<tr>
<th>Full Instance Customer</th>
<th>Shared Instance Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Workstation and WebView</td>
<td>WebView access only</td>
</tr>
</tbody>
</table>

Note that all configurations for a shared instance customer must be performed by the service provider that manages the instance.

**Creating a WebView User**

Cisco ICM WebView users can use a Web browser to:

- Connect to the WebView server.
- Monitor, define, and modify Cisco ICM WebView reports.

For ICM software to recognize and authorize a WebView user, you must add that user with the Configuration Manager User List tool.

---

Note

Only ICM users are allowed to log in to WebView. The NT Account “Administrator” by default is not able to log into WebView.

To log into WebView, the “Administrator” has to be made an ICM user AND the following two string registry settings must be created and set to TRUE:

- HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc\ICM\WebView\AllowAdminLogin
- HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc\ICM\<instance>\web\AllowAdminLogin

Where <instance> is the ICM instance name on the WebView Server. See Appendix F, “Registry and Property File Settings” for more details.
Creating a WebView User

How to create a WebView user

Step 1  In the ICM Admin Workstation folder, open the Configuration Manager utility.

Step 2  From the menu bar, select the User List tool.

Step 3  If you have not selected the option to have the data automatically displayed when you open the tool, click Retrieve to enable the Add button.

Step 4  Click Add User.

An ICM user is one who has access to ICM configuration data.

Each user who can access the ICM configuration data must have a valid NT user name and password.

Note  ICM user names must begin with a letter and can contain only letters and numbers. If the NT user name contains characters other than the preceding, remove those characters from the ICM user name. For example, hyphens (-) are not allowed in user names.

The password is restricted to the 7-bit printable ASCII characters (any of the 94 characters with the numeric values from 32 to 126). Control characters (for example, ‘tab’) and international characters are not allowed. This means passwords cannot be entered in a non-Western alphabet, such as Kanji.

Step 5  In the user Attributes tab, enter the user’s Domain name, user name, and password.

Note  The user’s domain name along with the user name become the WebView login name. This combined name cannot be longer than 24 characters.

The password becomes the WebView password.

Once these are entered and saved, the new ICM user can use that domain name, user name, and password to open WebView.

The user’s password expiration date is set by the user’s domain, not by WebView.
If you want the user to be able to create other WebView users, also select **Can create other user accounts**. See the Configuration Manager’s User List tool online help for descriptions of each attribute (data property).

**Step 6**  
Click **Save**.

---

**Note**  
Creating a WebView user by using the User List tool enables that user to see all WebView data, not just data for an agent team as is the case of a supervisor of an agent team.

---

**Logging into Your WebView Installation**

Use the following procedure to test that you have correctly installed WebView.

**How to log in to WebView**

**Step 1**  
Open your browser window.

**Step 2**  
In the Address bar in Internet Explorer, enter the WebView URL. Use the following format:  
http://Admin Workstation/instance

Where:

- The name of the Admin Workstation is the name of the WebView server (the computer) containing the ICM Admin Workstation on which WebView is enabled.
- The instance is the ICM instance name on that WebView server.

For example:  
http://Boston1/cust1

**Step 3**  
Press the **Enter** key on your keyboard. The software prompts you for a username and password.

**Step 4**  
Enter your WebView username and password. Use the following format:  
domainname/username

Where:
• **Domainname** is the name of the domain where the user has his/her NT account.

• **Username** is the name assigned to the user by the WebView administrator.

For example: **sherwood/rhood**

**Note** The username is case sensitive.

If you have installed WebView correctly, the browser displays the opening WebView page.

---

**Figure 3-1 Summary Example of Log In User Input**

- WebView URL in browser address/location bar: http://Boston1/floor2
- Username in WebView username text box: Cambridge4/jsmith
- Password in WebView password text box: your secret password

---

**Troubleshooting Your WebView Installation**

If your browser does not display the opening WebView page, check the following:

• Are you using one of the supported browsers?

• Did you use the correct the URL? http://Admin Workstation/instance

• Did you enter the correct domain name and username for the username and enter the correct password?

• Confirm that your Cisco ICM software WebView installation meets all of the requirements listed Chapter 2.

For more trouble shooting tips, see Appendix G, “Troubleshooting Tips.”

If your browser still does not display the WebView home page, contact Cisco Connection Online (CCO) as described in “About This Guide” at the beginning of this guide.
Setting Up Other WebView Users

Use the Configuration Manager utility to set up user accounts for any users who need to access WebView on your Admin Workstation. See Creating a WebView User earlier in this chapter, for an overview on adding a new user.

Each user needs to:

- Be added as a user with the ICM Configuration Manager utility.
- Have network access to the Cisco ICM software WebView Admin Workstation.
- Install a supported Web browser.
- Enable the browser’s settings so that with every visit to a real-time report monitoring page, the version of that page in the browser’s cache will be compared and updated to any newer version on the Cisco ICM software WebView Admin Workstation.
- Know how to enter the correct WebView URL:
  http://AdminWorkstation\instance
- Know how to enter the correct domain name and username for the username and how to enter the correct password.
- Know that help is available for using WebView from the WebView window.

WebView User’s Password Expiration and Domain Security Settings

WebView (ICM) users take their security setting from the domain on which they are created. WebView users also cannot create or change their password from within WebView. However, the WebView administrator can create and change WebView users passwords.

Therefore, the WebView administrator must be aware of the domain security policy setting on password expiration so that WebView users are not accidentally locked out of their accounts.
Supervisors and WebView Reports

WebView supervisors can use a Web browser to:

- Connect to the WebView server.
- Monitor WebView reports for their team(s).

Supervisors can see only their agent team reports. No agent in their teams or other teams can see any WebView data, as they are not ICM users.

Supervisors are agents who are ICM users with limited privileges. All other agents are not ICM users (unless they are specifically made such) and so cannot run WebView reports.

**Note**

A supervisor agent can see report data only on the agents in that supervisor’s team while an ICM administrator (one created through the Configuration Manager’s User List tool) can see report data on all agents.

See the ICM Configuration Manager’s online help for how to make an agent a supervisor.

**Note**

- The supervisor does not use a login name and password created by the ICM User List tool.
- If the supervisor also has an ICM account created by the User List tool, then the supervisor login name (created in the Supervisor tab of the Agent Explorer) must be different from the user login name created in the User List tool.
- The agent’s domain sets the expiration date on the password.
Upgrading From a Previous Version of ICM WebView

You should see the Cisco ICM/IP Contact Center Enterprise Edition Upgrade Migration Guide for:

- How to upgrade from a previous version of WebView software to the current version
- How to upgrade your custom templates

Regarding Custom Template Name Changes

If you change the name of a custom template, the reports saved using them are no longer accessible.

Saved reports store the template name with rest of the parameters. There is no way for WebView to know that the new custom template is the same (replacement) as the old one if you change its name.

Therefore if the name of a custom template changes to reflect a template version change, the saved report definition using that custom template is NOT automatically updated to reflect that change as well. In that case, the saved report definition becomes invalid after the template name change.

There is no correlation between a custom template and Cisco provided template. A change in a Cisco provided template should not affect a custom template. Once a customer deploys a custom template (which could be based on Cisco provided
Regarding Custom Template Name Changes

template), it is treated as a separate template. So as long as the customer does not change the name of custom template, the saved reports based on the custom templates should work.
The WebView Database

This appendix includes the following:

- What is the WebView Database?, page B-1
- Migrating Saved Reports to the WebView Database, page B-2
- Installing one WebView database on multiple servers, page B-2
- Installing more than one WebView Database, page B-3
- The WebView Database and the ICM Databases, page B-5
- All WebView Database Tables, page B-7

What is the WebView Database?

When WebView is installed on an ICM AW server, a WebView database consisting of Microsoft SQL tables is created on that server. The WebView database is used to store and track saved reports, favorites, and scheduled report jobs:

- When you save a report definition, the template name, report items, and date and time range used to generate the report are stored in the WebView database.
- When you mark a report as a favorite, that user preference is stored with the report in the WebView database.
When you schedule a report job, the report schedule with its parameters are stored in the WebView database. If you schedule a job to run once, the job is removed from the database after it has executed. If you schedule a recurring job, the job remains in the database, executing each day and time that you specified, until you delete the job in WebView.

**Note**
Only saved reports stored in the WebView database can be accessed and used in WebView.

### Migrating Saved Reports to the WebView Database

Starting in WebView 5.0, the WebView database is used to store saved reports. When you are upgrading from a WebView system prior to WebView 5.0, the WebView installation automatically migrates most saved report files to the WebView database, with two exceptions:

- Saved reports created with templates that have been replaced by templates in different reporting categories are not migrated to the database.
- Saved reports created with templates that have been deleted and not replaced are not migrated to the database.

### Installing one WebView database on multiple servers

If you have more than one WebView server pointing to the same historical database, on the other server(s), when you setup WebView with ICM Setup, you can point to the name and location of the WebView database that you want all the servers to use.

In this way, people in different locations can have access to the same reports (especially shared reports), report favorites list, and report schedules.
Installing more than one WebView Database

You can install a WebView database on more than one WebView server. Each WebView database would point to the same ICM database. You might do this to create a backup WebView database.

**Note**

The following is a procedure for creating a second WebView database. But be aware that while you can create more than one WebView database, ICM (or WebView) does not automatically synchronize WebView databases.

You have to synchronize the databases manually either by recreating all the report templates, favorites, and schedules in the second database and then by adding changes to the second database when you change anything in the first one, or by creating a program in SQL to automatically synchronize the databases.

To create a second WebView database on a second server, follow the instructions in the *Cisco ICM Software WebView Installation Guide* for installing WebView. However, when you select the WebView database option, in the appropriate dialog box, enter the name of the second server with it’s location.

**To create a second (or backup) WebView database**

**Step 1** Install WebView on a second ICM AW or if you have already installed WebView on a second AW, run ICM Setup on that AW.

**Step 2** In the Instance Components section of the Setup dialog box, select AW and Edit.

**Step 3** In the Real-time Distributor Node Properties dialog box, select WebView Reporting.

**Step 4** In the WebView database host name text box, enter the name of the second AW. This is the name of the computer where you want the second WebView database.

**Step 5** Click Next and proceed with the setup. If you have already installed WebView on this server, keep clicking Next until the installation is complete.

**Step 6** When the installation is complete, and you are prompted in the Cisco ICM Setup dialog box, you can exit from Setup.

**Step 7** Run WebView on the second AW and manually recreate all the reports, favorites, and schedules that are on the first AW (if you want them to be the same).
Note  WebView does not synchronize the two databases. If you make a change to the WebView database on the first AW after you recreate it on the second AW, you must also manually make that change on the second AW.

To automatically synchronize the two WebView databases, you must create a SQL script.
The WebView Database and the ICM Databases

The following two diagrams illustrate how you might setup ICM and WebView databases in a contact center.

**Figure B-1  Two WebView AWs with One WebView Database**

- Both WebView AWs share one WebView database.
- Each AW has a separate real-time database which is updated from the ICM central controller.
- Both AWs get their historical data from one database, the ICM HDS.
Figure B-2  Two WebView AWs with a WebView Database on Each

In Figure B-2:

- Each WebView AW has its own WebView database. These cannot be automatically synchronized. If you change one, you have to manually change the other to keep them synchronized.
- Each AW has a separate real-time database which is updated from the ICM central controller.
- Both AWs get their historical data from one database, the ICM HDS.
All WebView Database Tables

The WebView database in ICm 6.0 consists of the following four database tables. These describe the structure of the database:

- WebViewVersion Table, page B-7
- Print Jobs Table, page B-7
- Report Table, page B-10
- User Preferences Table, page B-12

WebViewVersion Table

Used by the WebView software for version checking of the WebView database. It describes the current schema of the database and shows the schema history.

Note

A composite primary key (WebViewVersion, LastUpdateDate) provides an event history of every time the customer runs or reruns the upgrade script.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Allow Nulls</th>
<th>Constraint/Index</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebViewVersion</td>
<td>Real</td>
<td>No</td>
<td>Primary Key</td>
<td>The version of WebView database</td>
</tr>
<tr>
<td>LastUpdateDate</td>
<td>DateTime</td>
<td>No</td>
<td>Primary Key</td>
<td>The date and time that the database was last created or upgraded.</td>
</tr>
</tbody>
</table>

Print Jobs Table

Contains one record for each scheduled print job.

Use the WebView Schedule Jobs Web page to add, update, and delete print jobs.
### Table B-2 Print Jobs Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>JobTrackID</td>
<td>A unique ID to track the print job.</td>
<td>Primary Key</td>
<td>char(50)</td>
<td>No</td>
</tr>
<tr>
<td>Frequency</td>
<td>The number of times the print job is to be run.</td>
<td></td>
<td>char(1)</td>
<td>No</td>
</tr>
<tr>
<td>TokenValue</td>
<td>A random number generated from the value of the job ID.</td>
<td></td>
<td>char(260)</td>
<td>No</td>
</tr>
<tr>
<td>JobTime</td>
<td>The time the print job is to be run.</td>
<td></td>
<td>char(260)</td>
<td>No</td>
</tr>
<tr>
<td>Command</td>
<td>The command-line string that schedules the print job.</td>
<td></td>
<td>char(1000)</td>
<td>No</td>
</tr>
<tr>
<td>ReportID</td>
<td>The unique ID identifying the report to be printed.</td>
<td></td>
<td>int</td>
<td>No</td>
</tr>
<tr>
<td>DayDates</td>
<td>The day(s) and date(s) on which the report is to be printed.</td>
<td></td>
<td>char(1000)</td>
<td>Yes</td>
</tr>
<tr>
<td>ClientJobID</td>
<td>The ID number of the job on the WebView client computer where the print job is created.</td>
<td></td>
<td>int</td>
<td>Yes</td>
</tr>
<tr>
<td>ClientHost</td>
<td>The name of the WebView host computer from which the print job is printed.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>PrintCount</td>
<td>The number of print jobs.</td>
<td></td>
<td>int</td>
<td>NO</td>
</tr>
<tr>
<td>ServerPrint</td>
<td>The server from which the job is printed.</td>
<td></td>
<td>int</td>
<td>No</td>
</tr>
<tr>
<td>Printer</td>
<td>The name of the printer selected to do the print job.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table B-2  Print Jobs Table (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileLocation</td>
<td>The location of the file to be printed.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>SaveFileName</td>
<td>The file name of the print job.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>OwnerID</td>
<td>The person who created the print job.</td>
<td></td>
<td>int</td>
<td>Yes</td>
</tr>
<tr>
<td>Instance</td>
<td>The ICM instance where the print job is created.</td>
<td></td>
<td>char(260)</td>
<td>No</td>
</tr>
<tr>
<td>ClientIP</td>
<td>The IP address of the computer on which the print job is created.</td>
<td></td>
<td>char(16)</td>
<td>Yes</td>
</tr>
<tr>
<td>FileFormat</td>
<td>The format of the report to be printed. For example: HTML, PDF, or XLS.</td>
<td></td>
<td>char(10)</td>
<td>Yes</td>
</tr>
<tr>
<td>PrinterPort</td>
<td>The port number to which the printer, selected for the print job, is connected.</td>
<td></td>
<td>char(10)</td>
<td>Yes</td>
</tr>
<tr>
<td>PrinterDriver</td>
<td>The print driver on the printer selected to do the print job.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>PrinterName</td>
<td>The name of the printer doing the print job.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>PrintLocation</td>
<td>The location of the printer selected for the print job.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>PDF_Is_Portrait</td>
<td>Attribute that specifies the orientation used when printing a report in PDF format</td>
<td></td>
<td>bit</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table B-2  Print Jobs Table  (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF_PaperSize</td>
<td>Attribute that specifies the paper size used when printing a report in PDF format</td>
<td></td>
<td>smallInt</td>
<td>Yes</td>
</tr>
<tr>
<td>FileNameAppendDate</td>
<td>Attribute, necessary when saving a report, that specifies whether a new file name is generated with the filename plus report creation date or a default name is used.</td>
<td>Default 0</td>
<td>bit</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Report Table

Contains one record for each saved report.

Use the WebView Reporting Web page to save, update, and delete reports.

Table B-3  Report Table

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReportID</td>
<td>The unique ID of the saved report.</td>
<td>Primary Key</td>
<td>int Identity (1, 1)</td>
<td>No</td>
</tr>
<tr>
<td>Instance</td>
<td>The ICM instance on which the report data is created.</td>
<td></td>
<td>char(10)</td>
<td>No</td>
</tr>
<tr>
<td>OwnerID</td>
<td>The unique ID of the person who saved the report.</td>
<td></td>
<td>int</td>
<td>No</td>
</tr>
<tr>
<td>CustomerID</td>
<td>The unique ID of the company to which the report creator belongs.</td>
<td></td>
<td>int</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table B-3  Report Table (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the saved report.</td>
<td>char(260)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>An optional user-entered description of the report.</td>
<td>text</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>isPublic</td>
<td>Whether or not the report is shared or private.</td>
<td>bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>isRealTime</td>
<td>Whether or not the report is real-time or historical.</td>
<td>bit</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>The report category.</td>
<td>char(260)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Table or graph</td>
<td>char(1)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>The name of the template from which the report was created.</td>
<td>char(260)</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>ItemsSelected</td>
<td>The items selected in the report to be reported on.</td>
<td>text</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>StartDateTime</td>
<td>If selected in the report, the beginning date and time for the report data.</td>
<td>datetime</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>EndDateTime</td>
<td>If selected in the report, the end date and time for the report data.</td>
<td>datetime</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>RelativeDateType</td>
<td>If selected in the report, the relative date and time range for the report data, relative to the day the report is run; for example: Today or Next Week.</td>
<td>SmallInt</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
**Table B-3  Report Table (continued)**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>DrillDownTemplate</td>
<td>The name of the report template assigned to a parent report component. Drill-down reports display filtered versions of the parent report data.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>DrillDownCategory</td>
<td>The category of drill-down template.</td>
<td></td>
<td>char(260)</td>
<td>Yes</td>
</tr>
<tr>
<td>Thresholds</td>
<td>The threshold or list of thresholds set in the report.</td>
<td></td>
<td>text</td>
<td>Yes</td>
</tr>
<tr>
<td>RefreshRate</td>
<td>The rate in seconds at which to refresh a real-time report.</td>
<td></td>
<td>int</td>
<td>Yes</td>
</tr>
<tr>
<td>Scale</td>
<td>Attribute that specifies the scale to show a report, in%.</td>
<td>Default 100</td>
<td>smallInt</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**User Preferences Table**

Contains one record for each user favorite report.

Use the WebView Favorites page to add, update, and delete report preferences.

**Table B-4  User Preferences Table**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Constraint/Index</th>
<th>Data Types</th>
<th>Allow Nulls</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerID</td>
<td>The unique ID of the person who designated the report as a favorite.</td>
<td>Primary Key</td>
<td>int</td>
<td>No</td>
</tr>
<tr>
<td>ReportID</td>
<td>The unique ID of the saved report.</td>
<td>Primary Key</td>
<td>int</td>
<td>No</td>
</tr>
</tbody>
</table>
Data Types

ICM software databases use the following data types.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>char(n)</code></td>
<td>Holds up to ( n ) characters. The storage size is determined by ( n ) (not by the actual data).</td>
</tr>
<tr>
<td><code>datetime</code></td>
<td>A date and time accurate to the second. Stored as two four-byte integers (eight bytes total): days before or since January 11900 and seconds since midnight.</td>
</tr>
<tr>
<td><code>float</code></td>
<td>Holds an eight-byte floating-point value with 15-digit precision.</td>
</tr>
<tr>
<td><code>image</code></td>
<td>Holds up to 2,147,483,647 bytes of binary data. The storage size is determined by the length of the data.</td>
</tr>
<tr>
<td><code>int</code></td>
<td>Holds a four-byte integer value between -2,147,483,648 and 2,147,483,647.</td>
</tr>
<tr>
<td><code>real</code></td>
<td>Holds a four-byte floating-point value with 7-digit precision.</td>
</tr>
<tr>
<td><code>smalldatetime</code></td>
<td>A date and time accurate to the minute. Stored as two two-byte integers (four bytes total): days since January 1, 1900 and minutes since midnight.</td>
</tr>
<tr>
<td><code>smallint</code></td>
<td>Holds a two-byte integer value between -32,768 and 32,767.</td>
</tr>
<tr>
<td><code>tinyint</code></td>
<td>Holds a one-byte integer value between 0 and 255.</td>
</tr>
<tr>
<td><code>varbinary(n)</code></td>
<td>Holds up to ( n ) bytes of binary data. The storage size is determined by the length of the data.</td>
</tr>
<tr>
<td><code>varchar(n)</code></td>
<td>Holds up to ( n ) characters. The storage size is determined by the length of the data.</td>
</tr>
</tbody>
</table>
Constraint/Index

The Constraint/Index Database Table Header indicates whether a table column is part of an index key value.

Each column can be part of more than one index. Each index can consist of one or more key fields. The database recognizes three types of keys:

- **PK: Primary key.** The unique identifier for the row within the table. This is the key most commonly used to access a row.
- **AK: Alternate key.** Another unique key that identifies the row.
- **IE: Inversion key.** A non-unique key within the row.
- **FK: Foreign key.** A copy of a key from another table which can be used to reference that table.

Alternate and inversion keys are numbered sequentially within each table. When two or more fields share the same designation (for example, IE1) the combination of those fields make up a single key.

All non-key fields can have the value NULL unless explicitly noted otherwise. Key fields are always designated as NULL (that is, the NULL value is allowed) or NOT NULL.
Date Format Support

WebView sets date format according to the language setting in the Internet Explorer browser. The languages appearing in the Internet Explorer language list are actually locales, a combination of ISO-639 language code and ISO-3166 country code.

The mapping between locales and date formats are defined in a new file, wvLocales.properties, in the form of:

<locale> = <date format>

For example:

De=DD/MM/YY

WebView supports 89 locales. The mapping between the locales and the associated date formats is shown in the following table:

**Table C-1  International Date Formats**

<table>
<thead>
<tr>
<th>Locales</th>
<th>DateFormat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>dd/mm/yy</td>
<td>Arabic</td>
</tr>
<tr>
<td>ar-ae</td>
<td>dd/mm/yy</td>
<td>Arabic (United Arab Emirates)</td>
</tr>
<tr>
<td>ar-bh</td>
<td>dd/mm/yy</td>
<td>Arabic (Bahrain)</td>
</tr>
<tr>
<td>ar-dz</td>
<td>dd/mm/yy</td>
<td>Arabic (Algeria)</td>
</tr>
</tbody>
</table>
Table C-1  International Date Formats  (continued)

<table>
<thead>
<tr>
<th>Locales</th>
<th>DateFormat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ar-eg</td>
<td>dd/mm/yy</td>
<td>Arabic (Egypt)</td>
</tr>
<tr>
<td>ar-iq</td>
<td>dd/mm/yy</td>
<td>Arabic (Iraq)</td>
</tr>
<tr>
<td>ar-jo</td>
<td>dd/mm/yy</td>
<td>Arabic (Jordan)</td>
</tr>
<tr>
<td>ar-kw</td>
<td>dd/mm/yy</td>
<td>Arabic (Kuwait)</td>
</tr>
<tr>
<td>ar-lb</td>
<td>dd/mm/yy</td>
<td>Arabic (Lebanon)</td>
</tr>
<tr>
<td>ar-ly</td>
<td>dd/mm/yy</td>
<td>Arabic (Libya)</td>
</tr>
<tr>
<td>ar-ma</td>
<td>dd/mm/yy</td>
<td>Arabic (Morocco)</td>
</tr>
<tr>
<td>ar-om</td>
<td>dd/mm/yy</td>
<td>Arabic (Oman)</td>
</tr>
<tr>
<td>ar-qa</td>
<td>dd/mm/yy</td>
<td>Arabic (Qatar)</td>
</tr>
<tr>
<td>ar-sa</td>
<td>dd/mm/yy</td>
<td>Arabic (Saudi Arabia)</td>
</tr>
<tr>
<td>ar-sy</td>
<td>dd/mm/yy</td>
<td>Arabic (Syria)</td>
</tr>
<tr>
<td>ar-tn</td>
<td>dd/mm/yy</td>
<td>Arabic (Tunisia)</td>
</tr>
<tr>
<td>ar-ye</td>
<td>dd/mm/yy</td>
<td>Arabic (Yemen)</td>
</tr>
<tr>
<td>be</td>
<td>dd/mm/yy</td>
<td>Byelorussian</td>
</tr>
<tr>
<td>ca</td>
<td>dd/mm/yy</td>
<td>Catalan</td>
</tr>
<tr>
<td>cs</td>
<td>dd/mm/yy</td>
<td>Czech</td>
</tr>
<tr>
<td>da</td>
<td>dd/mm/yy</td>
<td>Danish</td>
</tr>
<tr>
<td>de</td>
<td>dd/mm/yy</td>
<td>German</td>
</tr>
<tr>
<td>de-at</td>
<td>dd/mm/yy</td>
<td>German (Austria)</td>
</tr>
<tr>
<td>de-ch</td>
<td>dd/mm/yy</td>
<td>German (Switzerland)</td>
</tr>
<tr>
<td>Locales</td>
<td>DateFormat</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>de-lu</td>
<td>dd/mm/yy</td>
<td>German (Luxembourg)</td>
</tr>
<tr>
<td>el</td>
<td>dd/mm/yy</td>
<td>Greek</td>
</tr>
<tr>
<td>en</td>
<td>mm/dd/yy</td>
<td>English</td>
</tr>
<tr>
<td>en-au</td>
<td>dd/mm/yy</td>
<td>English (Australia)</td>
</tr>
<tr>
<td>en-ca</td>
<td>dd/mm/yy</td>
<td>English (Canada)</td>
</tr>
<tr>
<td>en-gb</td>
<td>dd/mm/yy</td>
<td>English (United Kingdom)</td>
</tr>
<tr>
<td>en-ie</td>
<td>dd/mm/yy</td>
<td>English (Ireland)</td>
</tr>
<tr>
<td>en-nz</td>
<td>dd/mm/yy</td>
<td>English (New Zealand)</td>
</tr>
<tr>
<td>en-us</td>
<td>mm/dd/yy</td>
<td>English (United States)</td>
</tr>
<tr>
<td>en-za</td>
<td>yy/mm/dd</td>
<td>English (South Africa)</td>
</tr>
<tr>
<td>es</td>
<td>dd/mm/yy</td>
<td>Spanish</td>
</tr>
<tr>
<td>es-ar</td>
<td>dd/mm/yy</td>
<td>Spanish (Argentina)</td>
</tr>
<tr>
<td>es-bo</td>
<td>dd/mm/yy</td>
<td>Spanish (Bolivia)</td>
</tr>
<tr>
<td>es-cl</td>
<td>dd/mm/yy</td>
<td>Spanish (Chile)</td>
</tr>
<tr>
<td>es-co</td>
<td>dd/mm/yy</td>
<td>Spanish (Colombia)</td>
</tr>
<tr>
<td>es-cr</td>
<td>dd/mm/yy</td>
<td>Spanish (Costa Rica)</td>
</tr>
<tr>
<td>es-do</td>
<td>mm/dd/yy</td>
<td>Spanish (Dominican Republic)</td>
</tr>
<tr>
<td>es-ec</td>
<td>dd/mm/yy</td>
<td>Spanish (Ecuador)</td>
</tr>
<tr>
<td>es-es</td>
<td>dd/mm/yy</td>
<td>Spanish (Spain)</td>
</tr>
<tr>
<td>es-gt</td>
<td>dd/mm/yy</td>
<td>Spanish (Guatemala)</td>
</tr>
</tbody>
</table>
### Table C-1 International Date Formats (continued)

<table>
<thead>
<tr>
<th>Locales</th>
<th>DateFormat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>es-hn</td>
<td>mm/dd/yy</td>
<td>Spanish (Honduras)</td>
</tr>
<tr>
<td>es-mx</td>
<td>dd/mm/yy</td>
<td>Spanish (Mexico)</td>
</tr>
<tr>
<td>es-ni</td>
<td>mm/dd/yy</td>
<td>Spanish (Nicaragua)</td>
</tr>
<tr>
<td>es-pa</td>
<td>mm/dd/yy</td>
<td>Spanish (Panama)</td>
</tr>
<tr>
<td>es-pe</td>
<td>dd/mm/yy</td>
<td>Spanish (Peru)</td>
</tr>
<tr>
<td>es-pr</td>
<td>mm/dd/yy</td>
<td>Spanish (Puerto Rico)</td>
</tr>
<tr>
<td>es-py</td>
<td>dd/mm/yy</td>
<td>Spanish (Paraguay)</td>
</tr>
<tr>
<td>es-sv</td>
<td>mm/dd/yy</td>
<td>Spanish (El Salvador)</td>
</tr>
<tr>
<td>es-uy</td>
<td>dd/mm/yy</td>
<td>Spanish (Uruguay)</td>
</tr>
<tr>
<td>es-ve</td>
<td>dd/mm/yy</td>
<td>Spanish (Venezuela)</td>
</tr>
<tr>
<td>et</td>
<td>dd/mm/yy</td>
<td>Estonian</td>
</tr>
<tr>
<td>fi</td>
<td>dd/mm/yy</td>
<td>Finnish</td>
</tr>
<tr>
<td>fr</td>
<td>dd/mm/yy</td>
<td>French</td>
</tr>
<tr>
<td>fr-be</td>
<td>dd/mm/yy</td>
<td>French (Belgium)</td>
</tr>
<tr>
<td>fr-ca</td>
<td>yy/mm/dd</td>
<td>French (Canada)</td>
</tr>
<tr>
<td>fr-ch</td>
<td>dd/mm/yy</td>
<td>French (Switzerland)</td>
</tr>
<tr>
<td>fr-lu</td>
<td>dd/mm/yy</td>
<td>French (Luxembourg)</td>
</tr>
<tr>
<td>hr</td>
<td>yy/mm/dd</td>
<td>Croatian</td>
</tr>
<tr>
<td>hu</td>
<td>yy/mm/dd</td>
<td>Hungarian</td>
</tr>
<tr>
<td>is</td>
<td>dd/mm/yy</td>
<td>Icelandic</td>
</tr>
</tbody>
</table>
## Table C-1  International Date Formats (continued)

<table>
<thead>
<tr>
<th>Locales</th>
<th>DateFormat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>it</td>
<td>dd/mm/yy</td>
<td>Italian</td>
</tr>
<tr>
<td>it-ch</td>
<td>dd/mm/yy</td>
<td>Italian (Switzerland)</td>
</tr>
<tr>
<td>ja</td>
<td>yy/mm/dd</td>
<td>Japanese</td>
</tr>
<tr>
<td>ko</td>
<td>yy/mm/dd</td>
<td>Korean</td>
</tr>
<tr>
<td>lt</td>
<td>yy/mm/dd</td>
<td>Lithuanian</td>
</tr>
<tr>
<td>lv</td>
<td>yy/mm/dd</td>
<td>Latvian (Lettish)</td>
</tr>
<tr>
<td>mk</td>
<td>dd/mm/yy</td>
<td>Macedonian</td>
</tr>
<tr>
<td>nl</td>
<td>dd/mm/yy</td>
<td>Dutch</td>
</tr>
<tr>
<td>nl-be</td>
<td>dd/mm/yy</td>
<td>Dutch (Belgium)</td>
</tr>
<tr>
<td>no</td>
<td>dd/mm/yy</td>
<td>Norwegian</td>
</tr>
<tr>
<td>pl</td>
<td>yy/mm/dd</td>
<td>Polish</td>
</tr>
<tr>
<td>pt</td>
<td>dd/mm/yy</td>
<td>Portuguese</td>
</tr>
<tr>
<td>pt-br</td>
<td>dd/mm/yy</td>
<td>Portuguese (Brazil)</td>
</tr>
<tr>
<td>ro</td>
<td>dd/mm/yy</td>
<td>Romanian</td>
</tr>
<tr>
<td>ru</td>
<td>dd/mm/yy</td>
<td>Russian</td>
</tr>
<tr>
<td>sk</td>
<td>dd/mm/yy</td>
<td>Slovak</td>
</tr>
<tr>
<td>sl</td>
<td>yy/mm/dd</td>
<td>Slovenian</td>
</tr>
<tr>
<td>sq</td>
<td>yy/mm/dd</td>
<td>Albanian</td>
</tr>
<tr>
<td>sr</td>
<td>yy/mm/dd</td>
<td>Serbian</td>
</tr>
<tr>
<td>sv</td>
<td>mm/dd/yy</td>
<td>Swedish</td>
</tr>
</tbody>
</table>
Table C-1  International Date Formats (continued)

<table>
<thead>
<tr>
<th>Locales</th>
<th>DateFormat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>th</td>
<td>dd/mm/yy</td>
<td>Thai</td>
</tr>
<tr>
<td>tr</td>
<td>dd/mm/yy</td>
<td>Turkish</td>
</tr>
<tr>
<td>uk</td>
<td>dd/mm/yy</td>
<td>Ukrainian</td>
</tr>
<tr>
<td>zh</td>
<td>yy/mm/dd</td>
<td>Chinese</td>
</tr>
<tr>
<td>zh-cn</td>
<td>yy/mm/dd</td>
<td>Chinese (China)</td>
</tr>
<tr>
<td>zh-hk</td>
<td>yy/mm/dd</td>
<td>Chinese (Hong Kong)</td>
</tr>
<tr>
<td>zh-tw</td>
<td>yy/mm/dd</td>
<td>Chinese (Taiwan)</td>
</tr>
</tbody>
</table>

This table covers 60% of Internet Explorer 6.0 supported locales, and 100% of localized Windows 2000 platforms with their default IE language settings.
APPENDIX D

About Template and Report Item Caching

Overview

This appendix describes:

- How WebView uses Caching, page D-1
- Configuring Basic Caching
- Enabling and Disabling Supervisor Caching

How WebView uses Caching

By default, ICM software WebView caches report templates and report items for each category. Caching improves system performance by reducing the number of times that WebView queries the database. Lists of cached items and templates are stored in the memory space of New Atlanta ServletExec.

Report items are cached only if the ICM database is not partitioned. Report templates are cached regardless of database partitioning. For more information on database partitioning, see the Cisco ICM Enterprise Edition Administration Guide.
Using the adminui.properties file, located in the `<ICM ROOT>/web/webview/reporting/servlet/properties/` directory of the WebView server machine, you can specify many caching settings. If you modify this file, you must restart the IIS Admin services on the WebView server machine for the changes to take effect.

You can manually refresh the cache by restarting the IIS Admin services.

You can configure basic caching properties, including enabling and disabling caching, and setting the cache refresh and purge times. You can also enable and disable separate caching for supervisors.

For NAM environments, you can enable customer call type filtering so that each customer has a separate cache for call type report items and templates that contains only those call types used by the individual customer.

**Note**
If you use the *Cisco ICM IP Contact Center Enterprise Edition Template Design Guide Using InfoMaker* to create custom templates or to delete templates, the new templates do not appear until the cache refreshes.

### Configuring Basic Caching

This section describes how to configure basic caching properties, including:

- Enabling and Disabling Caching
- Setting the Cache Refresh Time
- Setting the Cache Purge Time Factor

### Enabling and Disabling Caching

By default, report template and item caching is enabled.

You enable and disable caching by setting the value of the `DISABLE_ITEM_LIST_CACHING` property in the adminui.properties file.

**To disable caching**

**Step 1** Set the value of the `DISABLE_ITEM_LIST_CACHING` property to `true`. 
Appendix D  About Template and Report Item Caching

Configuring Basic Caching

Step 2  Restart the IIS Admin services for the change to take effect.

To enable caching

Step 1  Set the value of the DISABLE_ITEM_LIST_CACHING property to false.
Step 2  Restart the IIS Admin services for the change to take effect.

Setting the Cache Refresh Time

By default, the cache refreshes every 120 minutes.

You set the cache refresh time by setting the value of the WEBVIEW_CACHE_LIVETIME property in the adminui.properties file.

To set the cache refresh time

Step 1  Set the value of the WEBVIEW_CACHE_LIVETIME property to the number of minutes after which you want the cache to refresh.
For example: WEBVIEW_CACHE_LIVETIME = 240
Step 2  Restart the IIS Admin services for the change to take effect.

Setting the Cache Purge Time Factor

The cache purge time factor is multiplied by the value set for the WEBVIEW_CACHE_LIVETIME property to determine when the cache is purged. By default, the cache purge time factor is 4 and the cache live time is 120 minutes, meaning that the cache is purged after 8 hours. You set the cache purge time factor by setting the value of the PURGE_TIME_MULTIPLIER property in the adminui.properties file.

If you notice that the size of the cache is consuming too much memory, set the value of this property to a small number so that the cache purges more often.
Templates and items that have been in the cache for less than the value set for the WEBVIEW_CACHE_LIVETIME property are not purged. For example, if the WEBVIEW_CACHE_LIVETIME property is set to 120, items that have been in the cache for fewer than 120 minutes are not purged.

**To set the cache purge time factor**

**Step 1**
Set the value of the PURGE_TIME_MULTIPLIER property to the factor by which you want to multiply the value of the WEBVIEW_CACHE_LIVETIME property.
For example: PURGE_TIME_MULTIPLIER = 2

**Step 2**
Restart the IIS Admin services for the change to take effect.

---

### Enabling and Disabling Supervisor Caching

Supervisors can log into WebView using their supervisor user names and passwords. If these supervisors run reports from the Agent report categories, they can view only data for those agents and skill groups that they supervise. Each supervisor can have his/her own cache for the agent report categories: Agent By Agent, Agent By Team, Agent By Skill Group, and Agent By Peripheral.

By default, report template and item supervisor caching is enabled for the Agent report categories.

A separate cache is maintained for each supervisor for the Agent report categories. Supervisors use the same cache as other WebView users for other report categories.

**Note**
If the size of the caches are consuming too much memory, you can either reset the PURGE_TIME_MULTIPLIER property or disable supervisor caching.

You enable and disable supervisor caching by setting the value of the ENABLE_SUPERVISOR_CACHING property in the adminui.properties file.

**To disable supervisor caching**

**Step 1**
Set the value of the ENABLE_SUPERVISOR_CACHING property to false.
Appendix D  About Template and Report Item Caching

Enabling and Disabling Supervisor Caching

Step 2  Restart the IIS Admin services for the change to take effect.

To enable supervisor caching

Step 1  Set the value of the ENABLE_SUPERVISOR_CACHING property to true.
Step 2  Restart the IIS Admin services for the change to take effect.
How To Update or Fix Corrupted Templates

If for some reason a Cisco template needs to be updated or is corrupted, you can use the PATCHPBL utility to regenerate the PPBO50.PBL files. This should update or fix the template.

The PATCHPBL utility does not update or fix custom templates created by the Custom Screen Builder. See the Cisco ICM IP Contact Center Enterprise Edition Template Design Guide Using InfoMaker for how to use that tool to create custom templates.

This appendix describes:

- What the PATCHPBL Utility Does, page E-1
- How to Run the PATCHPBL Utility, page E-2

What the PATCHPBL Utility Does

The PATCHPBL utility imports PowerBuilder templates (data windows) from .SRD files into PPBO50.PBL (PowerBuilder Library) files. Each report category has its own PPBO50.PBL file. If a needed PPBO50.PBL file does not exist, the utility creates that file. WebView uses the PPBO50.PBL files to display the report templates.

The Cisco report templates are stored in the appropriate report category directories as .SRD files. In each directory, there is an srdlist.txt file that lists all the Cisco templates in that category. The PATCHPBL utility goes through each of these directories, reads each category’s srdlist.txt file, and imports all the listed
SRD files into the PPBO50.PBL file. The utility does NOT delete any template in the PPBO50.PBL file that is not in the srldlist.txt file. That way custom templates remain unaltered in the regenerated PPBO50.PBL file.

How to Run the PATCHPBL Utility

To run the PATCHPBL utility, from the command-line window, use the following command format:

```
PATCHPBL -root <drive>:\ICM\<instance_name>\aw
```

For example: PATCHPBL -root C:\ICM\Cisco\aw

The PATCHPBL utility is located in the ICM\bin directory and is put there when WebView is installed.
Registry and Property File Settings

The following registry and property file settings on the WebView server are important for an administrator to know:

- **AllowAdminLogin**, page F-1
- **Event**, page F-2
- **WebView.properties**, page F-3
- **jagconnection.properties**, page F-3
- **wvLocale.properties**, page F-3
- **adminui.properties**, page F-3

**Note**

Registry entries that are set as a result of entries in ICM setup are not recorded here.

Registry Settings

**AllowAdminLogin**

This consists of the following two registry setting keys.

**Key:** HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\WebView
Name: AllowAdminLogin
Data Type: STRING
Acceptable Values: [TRUE | FALSE]
Purpose: Allows the Administrator account to log into WebView. This is disabled by default. A value of TRUE means the Administrator can log in. A value of FALSE means the Administrator cannot log in.

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance>\web
Name: AllowAdminLogin
Data Type: STRING
Acceptable Values: [TRUE | FALSE]
Purpose: Specifies which user WebView uses to connect to the database when getting the items list for reports. If the value is TRUE, then WebView connects as the DBO (DataBase Owner). If the value is FALSE (default), then WebView connects as the logged in WebView user.

Event

Key: HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\<instance>\Distributor\RealTimeDistributor\CurrentVersion\Logger\CurrentVersion\HistoricalData\Event
Name: Event
Data Type: DWORD
Acceptable Values: [0 | 1]
Purpose: Enables/Disables event replication from the logger to the HDS. 0 is disable, 1 is enable. If Event replication is disabled, then no events will appear in Event Viewer. 0 is the default.
Property Files

WebView.properties

Location: \ICMRoot\web\webview\reporting\servlet\WebView.properties

Purpose: Contains all WebView-specific localized information in English. This is the default that will be used if there is no localized file for the default locale of the WebView Server machine.

jagconnection.properties

Location:
<EAServerRoot>html\classes\com\cisco\atg\jagconnection.properties

Purpose: Specifies connection parameters for WebView to connect to the Jaguar Server. The values in this file should be modified if you change connection parameters for Jaguar such as Username, Port, Password, and so on.

wvLocale.properties

Location: \ICMRoot\web\webview\reporting\servlet\wvLocale.properties

Purpose: Contains the mapping between locales and date format.

adminui.properties

Location:
<ICMRoot>\web\webview\reporting\servlet\properties\adminui.properties

Purpose: The main properties file for WebView. Allows you to define settings for things like enabling various caching mechanisms, setting cache timeouts, graph sizing, turning on/off call type filtering between customers, turning on/off debugging for java beans and .jsp pages, and specifying various localization parameters such as country, language, and so on.
Troubleshooting Tips

Tip Organization

This appendix is organized first by the software in which you might find a problem. Then it is organized by found problems with their solutions.

Overview

If you are having problems with your WebView installation, first check Troubleshooting Your WebView Installation in Chapter 3. That section covers what you should know when you log into WebView. This appendix lists additional troubleshooting tips.

If you still have problems, contact the Cisco Connection Online (CCO) as described in “About This Guide” at the beginning of this guide.

This appendix contains the following sections:

- Troubleshooting by following the WebView system program-execution flow, page G-3 (This is a generic troubleshooting section. The rest of the troubleshooting tips are for specific problems.)
- Error 2221 when installing AW as a real-time distributor, page G-5
- Unable to Log into WebView, page G-5
- Graphical Reports and the Job Scheduler: Incorrect display and improper function, page G-6
• Getting Object support and ActiveX control support error messages when using the Job Scheduler, page G-8
• Third-Party Software Installation Error Message: IIS Admin Service not correctly configured, page G-9
• World Wide Publishing Service: Stopping it and restarting WebView, page G-10
• Java code displayed on opening Webview, page G-11
• Error message on attempting to select a WebView template, page G-12
• Error message after changing the Jaguar Admin Password, page G-12
• Large or many historical reports slow the system, page G-13
• WebView-Only User Unable to Change Password, page G-14
• Jaguar Server Installation Fails, page G-14
• The Windows Scripting Host must be installed, page G-16
• Slow Logger Performance or ICM Logger crashes, page G-17
Troubleshooting by following the WebView system program-execution flow

Figure G-1  A diagram of the WebView system program-execution flow

Troubleshooting by following the WebView system program-execution flow
The program-execution flow in Figure G-1 described

Step 1  The client makes a request to access WebView.
Step 2  IIS displays WebView to the user.

*Note*  In ICM, authentication is handled by IIS/NT authentication, no UI Server requests are necessary

Step 3  After several requests and responses (steps 1 and 2 repeated a few times) client requests a report.
Step 4  NewAtlanta is called to compile the JSP page.
Step 5  Jaguar component is invoked to query the database.
Step 6  Query is sent based on the template chosen.
Step 7  Data is returned to Jaguar.
Step 8  Jaguar renders the data as HTML based on the chosen template.
Step 9  NewAtlanta uses the HTML to finish compiling the page.
Step 10  Page is served back to user.

**Example G-1  Troubleshooting: What can be observed from the program-execution flow**

<table>
<thead>
<tr>
<th>If the problem is…</th>
<th>Try looking at…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t log in under ICM</td>
<td>ICM Config Manager</td>
</tr>
<tr>
<td>No items are displayed</td>
<td>The Jaguar log</td>
</tr>
</tbody>
</table>
| **No pages are displayed** | Check that “Show friendly HTTP error messages” is disabled in Internet Explorer to ensure you are seeing an accurate error message.  
Check that the “Default Web Site” is running under Control Panel->Administrative Tools->Internet Services Manager |
Error 2221 when installing AW as a real-time distributor

Problem:

In ICM Setup, when installing the AW as a real-time distributor, the following error message displays when selecting Next on the screen where you choose the real-time distributor and AW type (standard):

SEVERE

Error 2221 occurred while trying to determine the current user security type.

Explanation:

This error usually occurs because the AW cannot contact the Domain Controller.

Solution:

Make sure that the AW is part of a domain, that a domain administrator is logged in, and that the domain can be reached and is started. If all else fails, sometimes rebooting the machine helps to solve the communication problem.

Unable to Log into WebView

Problem:

Logging into WebView fails.
Graphical Reports and the Job Scheduler: Incorrect display and improper function

Explanation:

Two possible causes for not being able to log in:

- You entered only your username at the login prompt. The WebView Log in requires your domain_name, a slash, and your username.
- The combination of your user Domain_Name/User_name exceeds 24 characters. The name combination cannot have more than 24 characters.

ICM software creates service logon user accounts for both the Logger and Distributor services. The domain\username of these accounts must not exceed 30 characters. The names are formed as follows:

Logger service name: <domain>\<instance name><Side><hostname>

Distributor service name: <domain>\<instance><hostname>

In ICM, the <instance> is limited to 5 characters and the <side> is limited to 1 character. This means that the combined total characters for <domain> + <hostname> must not exceed 24 characters.

Solution:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Make sure you include both your domain name and your ICM (WebView) user name as the login name; for example: Boston/JSmith</td>
</tr>
<tr>
<td>Step 2</td>
<td>Make sure that the combined characters for both the domain name and the user name do not exceed 24 characters.</td>
</tr>
</tbody>
</table>

Graphical Reports and the Job Scheduler: Incorrect display and improper function

Problem:

Incorrect display of graphical reports and/or the Job Scheduler does not function properly.
Explanation:

To view graphical reports and use the Job Scheduler in a Microsoft Internet Explorer browser, all ActiveX Controls and plug-ins must be enabled in the browser's Security Settings.

Solution:

If graphical reports are displaying incorrectly or the Job Scheduler is not functioning correctly, you should check the Security settings and modify them if necessary. The following directions apply to Microsoft Internet Explorer 6.0 SP1 and 5.5 SP2.

To ensure that the Microsoft Internet Explorer Security settings are set correctly

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click <strong>Tools&gt; Internet Options</strong> in the browser's menu. The Internet Options window opens.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>Security</strong> tab.</td>
</tr>
<tr>
<td>3</td>
<td>Click <strong>Local Intranet</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>Click <strong>Custom Level</strong> in the Security level for this zone section. The Security Settings window opens.</td>
</tr>
<tr>
<td>5</td>
<td>In the ActiveX Controls and Plug-ins section, ensure that the <strong>Enable</strong> radio button is selected for the following options:</td>
</tr>
<tr>
<td></td>
<td>• Download signed ActiveX Controls.</td>
</tr>
<tr>
<td></td>
<td>• Initialize and script ActiveX Controls not marked as safe.</td>
</tr>
<tr>
<td></td>
<td>• Run ActiveX Controls and Plug-ins.</td>
</tr>
<tr>
<td></td>
<td>• Script ActiveX Controls marked safe for scripting.</td>
</tr>
<tr>
<td>6</td>
<td>Click <strong>OK</strong> to apply the settings and close the Security Settings window. If a dialog box opens, asking <em>Are you sure you want to change the security settings for this zone</em>, click <strong>Yes</strong>.</td>
</tr>
<tr>
<td>7</td>
<td>Click <strong>OK</strong> to close the Internet Options dialog box. The Job Scheduler and graphical reports now function correctly.</td>
</tr>
</tbody>
</table>
Getting Object support and ActiveX control support error messages when using the Job Scheduler

Problem:

Clicking on the Job Scheduler link displays the following error message:

- “Object doesn’t support this property or method”

and/or

- “An ActiveX Control on this page is not safe. Your current security settings prohibit running unsafe controls on this page. As a result, this page may not be displayed as intended.”

Conditions:

Depending on the subnet configuration for the WebView client and the WebView Server, the security settings on the WebView client may not be appropriate.

Solution:

Either security setting (A) may be sufficient or both (A) and (B) may be required. Apply (A) first. If it does not work, then apply (B) also.

Security Setting A:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Select Tools -&gt; Internet Options -&gt; Security -&gt; Local Intranet -&gt; Custom Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the “Run ActiveX controls and plugins” list, under:</td>
</tr>
<tr>
<td></td>
<td>- “Download signed activeX controls,” select Prompt.</td>
</tr>
<tr>
<td></td>
<td>- “Download unsigned ActiveX controls,” select Disable.</td>
</tr>
<tr>
<td></td>
<td>- “Initialize and script activeX controls not marked as safe,” select Enable.</td>
</tr>
<tr>
<td></td>
<td>- “Run ActiveX controls and plugins,” select Enable.</td>
</tr>
<tr>
<td></td>
<td>- “Script ActiveX controls marked safe for scripting,” select Enable.</td>
</tr>
</tbody>
</table>
Security Setting B

Step 1
Select Tools -> Internet Options -> Security -> Local Intranet -> Custom Level

Step 2
In the “Run ActiveX controls and plugins” list, under:

- “Download signed activeX controls,” select Prompt.
- “Download unsigned ActiveX controls,” select Disable.
- “Initialize and script activeX controls not marked as safe,” select Enable.
- “Run ActiveX controls and plugins,” select Enable.
- “Script ActiveX controls marked safe for scripting,” select Enable.

Third-Party Software Installation Error Message: IIS Admin Service not correctly configured

Problem:

During the installation of the 3rd Party Software for WebView, an error message says that the IIS Admin Service was configured incorrectly.

Explanation

Some operations can cause the IWAM account, which is the identity under which out of process IIS applications run, to become out of sync with the COM+ data store and IIS or the SAM.

When IIS Admin Service starts up, the account information stored in the IIS Metabase is synchronized with the local SAM, but the COM+ applications are not automatically updated. The result of this is that requests to out of process applications fail.

Running the synciwam.vbs admin script updates the IIS COM+ applications with the correct identity and solves this problem.
Solution:

Step 1 Go to the `<IIS Install Drive>/Inetpub/AdminScripts/synciwam.vbs` directory.
Step 2 Right click `synciwam.vbs`.
Step 3 Select `Open with Command Prompt`. A command window opens. Wait until it closes. This runs the `synciwam.vbs` script and fixes the problem.

World Wide Publishing Service: Stopping it and restarting WebView

Problem:

Stopping the world wide web publishing service stops WebView but WebView is not back when the service is restarted

Explanation:

Stopping the Web Publishing service, but not the IIS Admin service, crashes New Atlanta with errors. The errors can be seen in the DBMON process (launched from the ServletISAPI root before stopping the service). When you restart the web publishing service, the New Atlanta does not start.

The effect of this problem is that if WebView is running and Web publishing is stopped, WebView goes down. Restarting the service does not bring WebView back up.

Workaround:

This error is due to a limitation in IIS. The workaround is to restart the IIS Admin Service.
To restart the IIS Admin Service

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Start button, select Settings &gt; Control Panel &gt; Administrative Tools &gt; Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the Services dialog box list of services, double click IIS Admin Service.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the IIS Admin Service Properties dialog box, click Start.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click OK and then exit the Services dialog box.</td>
</tr>
</tbody>
</table>

Java code displayed on opening Webview

Problem:

When you attempt to open WebView, java code is displayed rather than the WebView window.

Explanation:

This can happen if some WebView files are missing from the New Atlanta directory.

If you uninstall the New Atlanta Servlet, some WebView files are removed along with the New Atlanta Servlet files because they are installed in the New Atlanta Servlet directory. If you then reinstall the New Atlanta Servlet files, and try to run WebView, you will have this problem.

Solution

Rerun ICM Setup in Upgrade All mode to make sure the missing WebView files get reinstalled correctly. When you run WebView and it displays properly, then you will know that all the files are installed correctly. If for some reason, you still see Java code when you open WebView, call the Cisco TAC.
Error message on attempting to select a WebView template

Problem:

When you open WebView and attempt to select a template, instead of displaying the list of templates, WebView displays the following error message: “org.omg.CORBA.OBJECT_NOT_EXIST: minor code: 0 completed: No”

Explanation:

This can happen if some WebView files are missing from the Jaguar directory. If you uninstall Jaguar, some WebView files are removed along with the Jaguar files because they are installed in the Jaguar directory. If you then reinstall Jaguar and try to run WebView, you will have the preceding problem.

Solution

Rerun ICM Setup in Upgrade All mode to make sure the missing WebView files get reinstalled correctly.

Error message after changing the Jaguar Admin Password

Problem

If you change the Jaguar admin password without also changing the Jaguar server properties file, you will get an error message when attempting to open the WebView templates window.

Explanation

When changing the Jaguar admin password, WebView requires that you change it in both the Jaguar Manager Login dialog box and in the Jaguar Server Properties file.
Large or many historical reports slow the system

Problem

Large or many historical reports run at the same time slow the system.

Explanation

Large historical reports can take extra time to create depending on the amount of data. Large numbers of historical reports can also slow down the simultaneous creation of real-time reports.

Solution 1

With the job scheduler, schedule historical reports, especially large ones, to be created during the evening hours or when the system is in less use.

Solution 2

For situations where the size or number of historical reports being created is slowing down the creation of real-time reports, set aside one WebView server for real-time reporting only and another for historical reporting only.

The simplest way to separate the servers is to ask the users to use one URL for real-time reports and other for historical reports. So that users can see only those templates that should be run on a server, you can also delete the real-time templates on one WebView server (using the Custom Screen Builder), and delete the historical templates on the other server.
WebView-Only User Unable to Change Password

Problem

When a WebView user’s password expires, that user cannot update the password from within WebView.

Explanation

ICM users must be aware of the domain security policy setting on password expiration. If it is anything other than never, an ICM WebView user who doesn't log into an ICM workstation, could have their password expire without their being able to change it.

An ICM user (a WebView user) password cannot be changed from within WebView, and it can only be changed or reset on an ICM workstation.

Solution

If a WebView user's password expires, the user must either login into an ICM workstation or see the domain administrator to reset the password. If you do not know the domain security policy setting, see your domain administrator.

Jaguar Server Installation Fails

Problem:

The Jaguar server fails to start.

Explanation:

This might happen if you selected a custom Jaguar installation that was not tested by Cisco. WebView supports the Jaguar server as configured by the Cisco Third Party installer and by the ICM installer. If you want to deviate from the typical Jaguar Server configuration, you should contact Cisco.
Jaguar Server Installation Fails

Solution:

Step 1  Delete the Jaguar server installation. For the procedure, see The correct procedure for deleting the Jaguar server installation, page G-15.

Step 2  Rerun the Cisco ICM Third-Party Setup and select the typical installation option.

Step 3  Then reinstall the ICM WebView software. To do so:
   a.  Rerun ICM Setup. Select the AW option and click Edit.
   b.  Accept all previous selections and make sure WebView is selected.
   c.  Click Next until the AW selections are complete and then Exit Setup.

The correct procedure for deleting the Jaguar server installation

Step 1  Stop the following NT services: IISAdmin, Jaguar, Sybase EP Management Agent, sysam

Step 2  Close any open Services control panel windows.

Step 3  Close any windows with the title Jaguar CTS Jaguar.

Step 4  Run the following two files in the following order:
   c:\program files\sybase\CIMRepository-3_0_0\bin\stoprepository.bat
   c:\Program Files\Sybase\AgentManager-3_0_0\bin\am_stop.bat

Step 5  From a command prompt, execute the following 3 commands in the following order:
   a.  %JAGUAR\%\bin\serverstart.bat -remove
   b.  c:\Program Files\Sybase\SYSAM-1_0\bin\installs.exe -n sysam -r
   c.  c:\Program Files\Sybase\shared-1_0\bin\sybjsvc.exe -d -sn Sybase EP Management Agent

Step 6  Delete the entire following two folders:
   c:\program files\sybase
   c:\flexlm

Step 7  Delete the following two registry keys:
   HKEY_LOCAL_MACHINE\Software\Sybase
   HKEY_LOCAL_MACHINE\Software\Sybase, Inc.
The Windows Scripting Host must be installed

Problem:

When installing the 3rd party software, you get the error: "The Windows Scripting Host must be installed.

Download and run the installer from Microsoft:

Setup will now abort."

Solution:

The windows scripting host is the engine that runs Visual Basic scripts (VBScripts) on a Windows computer. It is a good thing to have installed on your machine, and it is necessary for the execution of the WebView Third-Party installer, which uses VBScripts for certain critical tasks.

Step 1  Go to the location defined in the URL and download the installer appropriate for your operating system. There is a version for Windows 2000, and one for Windows 95, 98, Me, and NT 4.0.

Step 2  After you have downloaded the installer, go to the folder that you downloaded it to and open it. Agree to all defaults.
Step 3  When the installation is done, restart your computer, and run the WebView Third-Party Installer.

Slow Logger Performance or ICM Logger crashes

Problem:

If you run WebView reports against the central controller database instead of the historical database, the performance of the ICM Logger can slow down and in some situations, the Logger will crash.

Explanation:

This condition can come up if you install WebView on a AW which is configured as a HDS but designated as a secondary AW on the system. The will cause the WebView ODBC settings to point to the Central Controller database instead of the HDS database.

Solution:

Only install WebView on a AW that is a HDS server and designated as a Primary AW. Rerun setup and select deselect Secondary. See the *Cisco ICM Enterprise Installation Guide* and the *ICM Setup* online help for installation instructions.

Agent Data Does Not Show Up in Reports

Problem:

When running an agent report for agents that have been configured, the data on the agents does not appear in the report.

Explanation:

You cannot create a report on an agent until you have enabled the agent data in ICM on the peripheral where the agent is assigned.
Agent Data Does Not Show Up in Reports

Solution:

Use the following procedure to enable agent data.

---

**Step 1**  
In the ICM Admin Workstation folder on the computer where WebView is installed, open the **Configuration Manager** utility. Use the online help or the appropriate **Configuration Guide** during the procedure if you have any questions.

**Step 2**  
In the Configuration Manager, open the **PG Explorer**.

**Step 3**  
In the PG Explorer, select the **peripheral** to which an agent(s) is assigned.

**Step 4**  
Select the **Peripheral** tab. If the peripheral’s client type is CallManager/Soft ACD, you must select, in the Peripheral tab, a **Default desk settings**. Otherwise, skip this step.

Agent desk settings are settings for an IPCC agent’s phone or PC screen that are defined in the ICM database. Other types of agents have these settings defined in the ACD.

If NONE is the only option in the selection list, you need to create desk settings. To create desk settings, use the Configuration Manager’s Agent Desk Settings List tool.

**Step 5**  
In the Agent Distribution tab, select **Enable agent reporting**.

**Step 6**  
Enter any needed agent distribution entries.

Agent distribution is the flow of agent data from a specific peripheral to a specific real-time distributor.

A real-time distributor is an Admin Workstation that receives real-time monitoring data directly from the ICM Central Controller. The distributor then passes this data on to other Admin Workstations at the same site. For each ICM site, typically two Admin Workstations are set up as distributors, but only one is active at any time.

You can stop the flow of all agent real-time data to a distributor when you are not viewing agent real-time reports.
INDEX

A

administrator
  creating 3-5
adminui.properties file  D-2
agents
  enabling agent data  G-17

B

basic caching  D-2

C

cache purge time factor  D-3
cache refresh time  D-3
caching  D-1
  customer call type filtering  D-2
disabling  D-2
disabling supervisor caching  D-4
  enabling  D-2
  enabling supervisor caching  D-4
  setting purge time factor  D-3
  setting refresh time  D-3
Category  B-11

D

DayDates  B-8
de-installing previous WebView version  2-3
Description  B-11
domain name  3-7
DrillDownCategory  B-12
DrillDownTemplate  B-12

E

enabling and disabling caching  D-2
enabling and disabling supervisor caching  D-4
Index

EndDateTime B-11
Error reporting
  third-party CD software 2-10

F

FileFormat B-9
FileLocation B-9
fixing corrupted templates E-1
Frequency B-8

G

Global Table B-7

H

hardware guidelines 1-3

I

ICM customers and instances 3-4
InfoMaker program 2-3
installing
  browser 2-6
  requirements 2-1
testing 3-7
upgrade 2-3
WebView 3-2

J

Jaguar Admin Password 2-11
Jaguar log file 2-13
deleing 2-14
  finding 2-13
  setting its size 2-13
JobTime B-8
JobTrackID B-8

L

LastUpdateDate B-7
Licenses 2-5
logging in
  example 3-8
  how to 3-7

N

Name B-11
New D-1
## Index

<table>
<thead>
<tr>
<th>New Atlanta Servlet Exec</th>
<th>D-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>third-party licenses</td>
<td>2-5</td>
</tr>
<tr>
<td>upgrade</td>
<td>2-3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerID</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>password</td>
</tr>
<tr>
<td>password expiration policy</td>
</tr>
<tr>
<td>PATCHPBL utility</td>
</tr>
<tr>
<td>PrintCount</td>
</tr>
<tr>
<td>Printer</td>
</tr>
<tr>
<td>PrinterDriver</td>
</tr>
<tr>
<td>PrinterName</td>
</tr>
<tr>
<td>PrinterPort</td>
</tr>
<tr>
<td>Print Jobs Table</td>
</tr>
<tr>
<td>PrintLocation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
</tr>
</thead>
<tbody>
<tr>
<td>RefreshRate</td>
</tr>
<tr>
<td>RelativeDateType</td>
</tr>
<tr>
<td>ReportID</td>
</tr>
<tr>
<td>report templates</td>
</tr>
<tr>
<td>deleted and replaced</td>
</tr>
<tr>
<td>report templates, creating new</td>
</tr>
<tr>
<td>requirements</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>SaveFileName</td>
</tr>
<tr>
<td>ServerPrint</td>
</tr>
<tr>
<td>server system sizing</td>
</tr>
<tr>
<td>setting cache purge time</td>
</tr>
<tr>
<td>size guidelines</td>
</tr>
<tr>
<td>clients</td>
</tr>
<tr>
<td>servers</td>
</tr>
<tr>
<td>StartDateTime</td>
</tr>
<tr>
<td>supervisor caching</td>
</tr>
<tr>
<td>disabling</td>
</tr>
<tr>
<td>enabling</td>
</tr>
<tr>
<td>supervisors</td>
</tr>
<tr>
<td>creating</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
</tr>
<tr>
<td>templates</td>
</tr>
<tr>
<td>deleted and replaced</td>
</tr>
<tr>
<td>testing installation</td>
</tr>
<tr>
<td>third-party software</td>
</tr>
<tr>
<td>installation log file</td>
</tr>
<tr>
<td>Thresholds</td>
</tr>
<tr>
<td>TokenValue</td>
</tr>
</tbody>
</table>
Index

troubleshooting
  additional tips  G-1
  initial steps  3-8

Type  B-11

U

upgrading templates  E-1
upgrade requirements  2-3
username
  format for entering  3-7
users
  setting up  3-9

W

WebView
  creating an administrator  3-5
  creating a user  3-5
  creating supervisors  3-10
  enabling agent data  G-17
  installing  3-2
  logging in  3-7
  logging in example  3-8
  setting up users  3-9
  testing installation  3-7
username and password  3-7

WebView system  1-1
  client sizing  1-3

server sizing  1-3
WebViewVersion  B-7